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Introduction
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Welcome!

 

We would like to congratulate you on your choice of Steinberg Nuendo! This program 
represents a new generation in audio recording and editing programs. 

One of the great myths of digital audio systems is that truckloads of audio hardware 
and DSP chips are necessary to build a capable audio workstation. Nuendo presents a 
different picture, by not only providing the tools for audio production today that per-
fectly expand upon the capabilities of existing audio workstations, it does so in a way 
that is actually forward looking. Nuendo needs no dedicated DSP hardware and so 
constantly adapts itself to the current state-of-the-art technology, thus providing a 
professional production platform for years to come.

As you get acquainted with the program you will find many more advantages. Ad-
vanced, automated mixing facilities with support for VST 2.0 plug-ins and virtual in-
struments, and ASIO 2.0 compatible audio hardware. Extremely flexible multiple 
Undo, with the possibility to selectively remove or modify applied audio processing at 
any point in the Undo history. Surround sound support that makes other systems look 
very inflexible. Nuendo is not only better; it's distinctly better.

The Nuendo Team has already benefited from the input they receive from Nuendo us-
ers: From this direct communication with the people actually using Nuendo in their 
professional working lives, a very clear picture emerged about in what direction Nu-
endo should develop. You are invited to join us in helping decide where we go next - 
Please visit the Nuendo web site and give us your feedback and suggestions.

See you there!

The Steinberg Nuendo team.
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About the Printed Manuals and the Online Help

 

The Nuendo documentation is divided into three sections:

 

The Basics book

 

The book you are reading now covers the following areas:

 

• Computer requirements.
• Installation issues.
• Setting up your system for audio, MIDI and/or video work.
• A guided tour of the main Nuendo windows.
• An introduction to the most common procedures for recording, playing back, mixing and edit-

ing in Nuendo.
• Basic concepts and terminology.
• A description of the general methods used when working in Nuendo.

 

In other words, this book does not go into detail on any Nuendo windows, functions 
or procedures.

 

The Operation Manual

 

This contains the main Nuendo reference documentation, with detailed descriptions 
of Nuendo operations, parameters, functions and techniques. You should be familiar 
with the concepts and methods described in the Basics book before moving on to the 
Operation Manual.

 

About Mac and Windows versions

 

The manuals cover both the Windows version and the Macintosh version of Nuendo, 
with screenshots taken from both platforms. While the two versions are nearly identi-
cal feature-wise, there are still some differences due to the properties of each plat-
form. For example, the available modifier keys are different, as are some of the basics 
for window handling.

 

• Whenever there is a difference between versions, this is clearly stated in the manuals.

 

In other words: if nothing else is stated, descriptions in the manuals are valid for both platforms.
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The Online Help

 

Nuendo utilizes HTML Help under Windows and Apple Help on the Macintosh. The 
contents of the Online help basically mirrors the complete Operation Manual text. 
There are several ways of bringing up the Help texts:

 

• Selecting “Contents” from the Help menu in Nuendo brings up the Help table of contents.

• Selecting “Index” from the Help menu brings up an alphabetical index of the Help contents.

• To get information about the active window or a dialog, press the [F1] key (Windows) or 
Help key (Mac) on the computer keyboard, or click the Help button in the actual dialog.

• Within a topic, related topics are sometimes directly accessible via clickable links.

• It’s also possible to search the online help for keywords.

 

Under Windows, this is done under the Search tab in the help browser; in the Mac help this is 
done in the Search field at the top of the Help Viewer window.

 

How you can reach us

 

On the Help menu in Nuendo, you will find an additional item for getting additional 
information and help:

 

• Selecting “Nuendo Website” launches your web browser application and opens the dedi-
cated web site for Nuendo.

 

On the Nuendo web site you can find support and compatibility information, answers to fre-
quently asked questions, links for downloading new drivers, etc.

 

❐

 

This item requires that you have a web browser application installed on your computer, 

 

and a working Internet connection.
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Installation and Requirements for Windows
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About this Chapter

 

This chapter describes the system requirements and installation procedures for 
Nuendo for Windows. Installing Nuendo for Macintosh is described on page 22.

 

Requirements

 

The following are the minimum requirements to run Nuendo on a PC running Win-
dows. Below the lists you will find additional information and recommendations 
about general computer and hardware requirements.

 

• A PC with a 266 MHz Pentium II processor, or an equivalent AMD processor (faster processors 
highly recommended).

• Windows 98, Windows 2000 or Windows NT 4.
• 128 MB RAM or more (256 MB recommended).
• Audio hardware compatible with DirectX, Windows Multimedia or ASIO (recommended). See 

page 14.
• Microsoft DirectX 7 (required only if your audio hardware communicates via DirectX).

 

For MIDI

 

While it is possible to play back MIDI with VST Instruments or via ReWire 2 without any 
additional equipment, the following is required for regular MIDI Input and Output:

 

• At least one MIDI Interface.
• At least one MIDI instrument.
• Any audio equipment necessary to listen to the sound from your MIDI devices.
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General computer hardware recommendations

 

Processing Power

 

There is a direct relation between the speed of your system and the number of audio 
channels and real-time processing power (effects, equalizers, etc) available. For further 
information about performance, see the section “Optimizing Audio Performance” on 
page 42.

 

RAM

 

Audio work requires a lot of RAM! In fact, there is a direct relation between the amount 
of available RAM and the number of audio channels that you can have running. As 
specified earlier, 128 MB is the minimum requirement, but as a general rule “the more 
the better” applies.

 

Hard Disk

 

For audio recording, it is very important to have a large and fast hard disk.

 

• The size of the hard disk determines how many minutes of audio you will be able to record. 
Recording one minute of stereo CD quality audio, requires 10 MBytes of hard disk space. 
That is, eight stereo Tracks in Nuendo use up 80 MB of disk space per recording minute.

• The performance of the hard disk has a significant impact on the number of audio chan-
nels you will be able to record and play back. 

Wheel Mouse

 

Although a regular mouse will work perfectly fine with Nuendo, we recommend that 
you use a wheel mouse, as this will speed up value editing and scrolling considerably. 
See page 124 and page 128.
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Audio Hardware

 

By audio hardware we mean a card capable of recording and playing back digital au-
dio using your hard disk as a storage medium. Nuendo will run with audio hardware 
that meets the following basic specifications:

 

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with proper drivers for the platform. A driver is a piece of software that allows a pro-

gram to communicate with a certain piece of hardware. In this case, the driver allows Nuendo to 
use the audio hardware. 

 

If the audio hardware has a specific ASIO driver

 

Professional audio cards often come with an ASIO driver written especially for the 
card. This allows for communication directly between Nuendo and the audio card. As 
a result, audio cards with specific ASIO drivers can provide lower latency (input-output 
delay), which is crucial when monitoring audio via Nuendo or using VST Instruments. 
The ASIO driver may also provide special support for multiple inputs and outputs, 
routing, synchronization, etc.

Audio card-specific ASIO drivers are provided by the card manufacturers. Make sure to 
check the manufacturer’s web site for the latest driver versions.

 

❐

 

If your audio hardware comes with a specific ASIO driver we strongly recommend that you 

 

use this.

If the audio card communicates via DirectX 

 

DirectX is a Microsoft “package” for handling various types of Multimedia under Win-
dows. Nuendo supports DirectX, or to be more precise, DirectSound, which is a part of 
DirectX used for playing back and recording audio. This requires two types of drivers:

 

• A DirectX driver for the audio card, allowing it to communicate with DirectX. If the audio card 
supports DirectX, this driver should be supplied by the audio card manufacturer. If it isn’t in-
stalled with the audio card, please check the manufacturer’s web site for more information.

• The ASIO DirectX Full Duplex driver, allowing Nuendo to communicate with DirectX. This driver 
is included with Nuendo, and does not require any special installation.
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If the audio card communicates via Windows Multimedia system 

 

If the card is Windows compatible, it can be used in Nuendo. The card then communi-
cates with Windows Multimedia system, which in turn communicates with Nuendo. 
This requires two types of drivers: 

 

• A Windows Multimedia driver for the audio card, allowing it to communicate with the Windows 
Multimedia system. This driver should be supplied by the audio card manufacturer, and is nor-
mally installed when you install the audio card.

• The ASIO Multimedia driver, allowing Nuendo to communicate with the Windows Multimedia 
system. This driver is included with Nuendo, and does not require any special installation.
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Hardware Installation

 

Installing the Copy Protection key

 

Included with the Nuendo package, you will find a hardware key (sometimes referred 
to as a “dongle”) that is part of the Nuendo copy protection scheme. Nuendo will not 
run if this key isn’t installed properly.

 

1. With the power to the computer switched off, plug the copy protection key into the com-
puter’s parallel port.

 

If you’re unsure which connector this is, please consult the operation manual that came with 
your computer. One end of the key has a connector with pins (as opposed to holes). The end 
with the pins is the one that goes into your computer. 

 

2. Plug any parallel devices you might have into the other end of the copy protection key.

 

❐

 

If your parallel port is “bi-directional” and the computer has problems recognizing the 

 

key, please switch the port over to its normal or compatibility mode.

 

Installing the Audio Hardware and its Driver

 

❐

 

Although Nuendo will run fine using a standard Windows compatible stereo In/Out audio 
card, please note that a basic design philosophy behind the product is based on the use of 
multiple output audio hardware. To enjoy all features available in Nuendo, multiple out-
put hardware is not only strongly recommended, but required. Information about com-
patible audio hardware can be found on the Nuendo website, which can be accessed from 

 

the Help menu.

1. Make sure you have the latest drivers for the audio hardware!

 

Please check the manufacturer’s web site for the latest versions.

 

2. Install the audio card and related equipment in the computer, as described in the card’s 
documentation.

3. Install the driver for the card.

 

There are three types of drivers that could apply: card-specific ASIO drivers, DirectX drivers and 
Windows Multimedia drivers:
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Specific ASIO driver

 

If your audio card has a specific ASIO driver it may be included with the audio card, but 
you should always make sure to check the audio card manufacturer’s web site for the 
most recent drivers. For details on how to install the driver, refer to the manufacturer’s 
instructions.

 

DirectX driver

 

If your audio card is DirectX compatible, its DirectX drivers will most likely be installed 
when you install the card (as with the Windows Multimedia driver). If you have down-
loaded special DirectX drivers for the audio card, you should follow the manufac-
turer’s installation instructions.

 

Windows Multimedia driver

 

These drivers are normally included with all types of regular PC audio cards. Some are 
even included with Windows itself. Depending on whether the audio card is “Plug’n’Play 
compatible” or not, the installation of the card is done differently:

 

• If the card is “Plug’n’Play compatible”, Windows will detect the card once it is plugged 
in, and ask for the necessary driver disks.

• If not, you need to use the “Add New Hardware” feature in the Control Panel to install the 
card and its drivers.

 

Refer to the documentation that comes with the card.

 

❐

 

Should you have an audio card, but no driver, please ask your music or computer dealer 

 

for help.

Testing the Card

 

To make sure the audio card will work as expected, perform the following two tests:

 

• Use any software included with the audio card to make sure you can record and play back 
audio without problems.

• If the card is accessed via a standard Windows driver, use the Media Player application (in-
cluded with Windows) to play back audio.
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Installing a MIDI Interface/Synthesizer card

 

Installation instructions for a MIDI Interface should be included with the product. 
However, here’s an outline of the necessary steps:

 

1. Install the interface (or MIDI synthesizer card) inside your computer or connect it to a “port” 
(connector) on the computer.

 

Which is right for you depends on which type of interface you have.

 

2. If the interface has a power supply and/or a power switch, turn it on.

3. Install the driver for the interface, as described in the documentation that comes with the 
interface.

 

This is most likely done using the “Add New Hardware” feature in the Windows Control Panel. It 
is likely that you will need a CD ROM or floppy disk supplied by the manufacturer of the MIDI 
interface.

 

Installing Nuendo

 

Defragmenting the Hard Disk

 

If you plan to record audio on a hard disk where you have already stored other files, 
now is the time to defragment it. Defragmentation reorganizes the physical allocation 
of space on the hard disk in order to optimize its performance. It is done with a special 
defragmentation program. In Windows 98, for example, you might look for the “Defrag” 
utility.

 

❐

 

It is crucial to the audio recording performance that your hard disk is optimized (defrag-

 

mented). You should make sure to defragment regularly.
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Installing the files on the CD-ROM

 

The installation procedure puts all files in the right places, automatically.

 

1. Insert the Nuendo CD-ROM.

2. A pop-up dialog appears automatically, containing three items: “Install”, “Browse this CD” 
and “Exit”.

 

If this dialog doesn’t appear, open the CD-ROM on the desktop, and double click the “Autorun.EXE” 
icon. 

 

3. To start the installation process, select “Install”.

 

A number of dialogs now appear:

 

• In one dialog you will need to fill in your name and the serial number of your Nuendo 
copy, and click OK.

 

You will find the serial number on the registration card that comes with the Nuendo package. 
Check the name and number in the confirmation dialog and click “Yes” if they are correct. Click-
ing “No” brings back the previous dialog.

 

4. Now the actual Nuendo installation procedure starts.

 

A number of dialogs will appear, allowing you to select in which folder on your hard disk you 
want to install the program, etc. To advance to the next “page” in the installation procedure, 
click the “Next” button. The “Previous” button takes you back to the previous page.

 

• In one dialog you are asked to select a folder for your “Shared” VST plug-ins. This folder is 
where you should place any third-party manufactured VST plug-ins, and other Steinberg 
VST plug-ins that can be used by other applications that support the VST plug-in standard.

 

Plug-ins that are put inside the shared folder will be available in Nuendo. However, the included 
Nuendo plug-ins are specific to Nuendo, and cannot be used with any other application. To avoid 
any possible conflict, the Nuendo specific plug-ins will be installed in their own VST plug-ins 
folder, located inside the Nuendo folder. 

 

5. Finally, a dialog box informs you that the installation was successful and recommends 
you to restart your computer.

6. Remove the CD-ROM and store it in a safe place.

 

This completes the installation of your Nuendo program! 
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The Items on the Start Menu

 

If you open the Windows Start menu, you will find a Nuendo group on the “Programs” 
submenu. This contains the following items:

 

• ASIO DirectX Full Duplex Setup.

 

This is where you make settings if your audio hardware uses DirectX for audio playback and re-
cording.

 

• ASIO DirectX Setup.

 

This allows you to make settings for the non-full duplex ASIO DirectX driver. Note that this Di-
rectX driver only supports audio playback, not audio recording. See page 35.

 

• ASIO Multimedia Setup.

 

This opens a dialog with settings for the ASIO (Audio Stream Input Output) system, which han-
dles audio recording and playback in Nuendo, if you are using the ASIO MME driver. This dialog 
can also be opened from within Nuendo. See the chapter “Setting up Your System” in this book.

 

• Nuendo.

 

This launches the actual program. 

 

There may also be additional items (such as Readme files) available on the Start menu. 
Please read all such files before launching Nuendo, since they may contain late infor-
mation not included in the manuals.
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Installation and Requirements for Macintosh
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About this Chapter

 

This chapter describes the system requirements and installation procedures for 
Nuendo for Macintosh. Installing Nuendo for Windows is described on page 12.

 

Requirements

 

The following are the minimum requirements to run Nuendo on the Macintosh. Below 
the lists you will find additional information and recommendations about general 
computer and hardware requirements.

 

• A Power Macintosh G3 or better (G4 recommended)
• MacOS 9 or later.
• 128 MB RAM or more (256 MB recommended).
• USB (required for copy protection dongle).
• ASIO-compatible audio hardware recommended (see page 24).

 

For MIDI

 

While it is possible to play back MIDI with VST Instruments or via ReWire 2 without any 
additional equipment, the following is required for regular MIDI Input and Output:

 

• At least one MIDI Interface.
• At least one MIDI instrument.
• Any audio equipment necessary to listen to the sound from your MIDI devices.
• OMS 2.3.8 or later (included).
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General computer hardware recommendations

 

Processing Power

 

There is a direct relation between the speed of your system and the number of audio 
channels and real-time processing power (effects, equalizers, etc.) available. For further 
information about performance, see the section “Optimizing Audio Performance” on 
page 42.

 

RAM

 

Audio work requires a lot of RAM! In fact, there is a direct relation between the amount 
of available RAM and the number of audio channels that you can have running. As 
specified earlier, 128 MB is the minimum requirement, but as a general rule “the more 
the better” applies.

 

Hard Disk

 

For audio recording, it is very important to have a large and fast hard disk.

 

• The size of the hard disk determines how many minutes of audio you will be able to record. 
Recording one minute of stereo CD quality audio, requires 10MBytes of hard disk space. 
That is, eight stereo Tracks in Nuendo use up 80MB of disk space per recording minute.

• The performance of the hard disk has a significant impact on the number of audio chan-
nels you will be able to record and play back. 

Mouse

 

Although a regular mouse will work perfectly fine with Nuendo, we recommend that 
you use a two-button mouse, and program the right mouse button to generate a 
[Ctrl]-click. This allows you to bring up context menus by right clicking (see page 121).



 

24

 

Audio Hardware

 

By audio hardware we mean a card capable of recording and playing back digital au-
dio using your hard disk as a storage medium. Nuendo will run with audio hardware 
that meets the following basic specifications:

 

• Stereo.
• 16 bit.
• Support of at least the 44.1kHz sampling rate.
• Is supplied with proper drivers. A driver is a piece of software that allows a program to commu-

nicate with a certain piece of hardware. In this case, the driver allows Nuendo to use the audio 
hardware. 

 

Using audio hardware with a specific ASIO driver

 

To be able to use an audio card with Nuendo on the Macintosh, the card must be ASIO 
compatible. That is, there must be an ASIO driver written especially for the card. Audio 
card-specific ASIO drivers are provided by the card manufacturers. Make sure to check 
the manufacturer’s web site for the latest driver versions.

 

❐

 

Some Macintosh audio hardware comes with a Sound Manager driver (i.e. without an 

 

ASIO driver). However, we recommend using ASIO compatible audio hardware only.

Using the built-in audio hardware of the Macintosh

 

As of this writing, most Macintosh models have built-in 16 bit stereo audio hardware. 
Depending on your preferences and requirements, this may be sufficient for use with 
Nuendo (although we recommend using multi-output audio hardware). To make use 
of the built-in audio hardware, you use the ASIO Sound Manager driver (automatically 
installed with Nuendo), which in turn communicates with the Sound Manager (the 
Mac’s built-in audio protocol). You don’t need to install any additional drivers.

 

❐

 

Some Macintosh models have audio outputs but no inputs. This means that you can only 

 

play back audio - recording is not possible without additional audio hardware.
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Hardware installation

 

Installing the Copy Protection Key

 

Included with the Nuendo package, you will find a hardware key (sometimes referred 
to as a “dongle”) that is part of the Nuendo copy protection scheme. Nuendo will not 
run if this key isn’t installed properly. The copy protection key for Nuendo Mac is an 
USB device. To install it, plug it into a free USB port on your computer.

 

• When you plug in the key, the Macintosh will automatically detect this, and ask whether 
you want to search for the necessary system extensions. Select “Cancel”.

 

The necessary system extensions are automatically installed when you install the program (see 
page 27).

 

Installing the Audio Hardware and its Driver

 

s

 

❐

 

Although Nuendo will run fine using the built-in audio hardware of the Macintosh, please 
note that a basic design philosophy behind the product is based on the use of multiple out-
put audio hardware. To enjoy all features available in Nuendo, multiple output hardware is 
not only strongly recommended, but required. Information about compatible audio hard-

 

ware can be found on the Nuendo website, which can be accessed from the Help menu.

1. Make sure you have the latest drivers for the audio hardware!

 

Please check the manufacturer’s web site for the latest versions.

 

2. Install the audio card and related equipment in the computer, as described in the card’s 
documentation.

3. Install the driver(s) for the card.

 

This is usually done by running an installer provided with the audio card (or downloaded from 
the manufacturer’s web site). Often, more than one driver will be installed: typically a general 
driver for the card allowing the Macintosh system to “recognize” the card, and an ASIO driver, al-
lowing Nuendo to communicate with the card.

 

4. Locate the installed ASIO driver for the hardware.

 

After installing Nuendo, you will need to copy this into Nuendo’s ASIO driver folder (see page 28).
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Installing a MIDI Interface

 

❐

 

The description below assumes you are using a USB MIDI interface. For other MIDI interface 
types (e.g. interfaces connected to a Serial Port PCI card), please follow the interface manu-

 

facturer’s instructions.

1. Make sure you have the latest version of OMS installed.

 

OMS (Open Music System) is an extension that allows the Macintosh to communicate with MIDI 
interfaces and other devices. OMS is required for MIDI input and output with Nuendo.

 

• OMS 2.3.8 is included on the Nuendo CD-ROM.

 

To install, locate and launch the OMS installer and follow the instructions on screen.

 

2. Connect the MIDI interface to the USB port on the Macintosh, following the installation in-
structions for the interface.

3. Install the necessary system software for the interface.

 

These should be included on a CD-ROM or similar with the interface, but you may want to check 
the manufacturer’s web site for the latest drivers. Most often, the interface drivers are installed 
by running a setup application - again, follow the installation instructions.

 

4. Run the OMS Setup application.

 

This allows OMS to locate the USB interface. Follow the instructions on screen.
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Installing Nuendo

 

Preparing the Computer

 

Defragmenting the Hard Disk

 

If you plan to record audio on a hard disk where you have already stored other files, 
now is the time to defragment it. Defragmentation reorganizes the physical allocation 
of space on the hard disk in order to optimize its performance. It is done with a special 
defragmentation program.

 

❐

 

It is crucial to the audio recording performance that your hard disk is optimized (defrag-

 

mented). You should make sure to defragment regularly.

File Sharing

 

The File Sharing utility may use processor power and “block” disk accesses, thereby 
slowing down the apparent performance of the computer. We recommend that you 
turn this off in the File Sharing control panel.

 

Virtual Memory

 

We recommend that you deactivate Virtual Memory in the Memory control panel be-
fore launching Nuendo.

 

Installing the files on the CD-ROM

 

1. Quit all applications so that you return to the Finder.

2. Disable any Virus protection software.

 

This is done by using control panels, or possibly by removing one or more Extensions and re-
starting the computer.

 

3. Put the CD-ROM in your drive.

4. Open and read the file “Read Me First” before continuing.

 

It may contain late breaking news pertinent to the installation.

 

5. Locate the Nuendo installer file and double click on its icon.
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6. In the dialog that appears, select a folder on the hard disk on which you want the program 
to be installed, and click Install.

7. At one point during the installation you will be asked to enter your serial number.

 

This can be found on the registration card included in the Nuendo package.

 

8. When the installation is finished, you will be requested to restart your Macintosh. Do so.

 

The program has now automatically created a Nuendo folder on your hard disk. It has 
put the relevant files there and also installed some files in your System folder.

 

9. Open the new Nuendo folder on your hard disk and check for “Late Changes” text files.

 

These list any changes to the program made after this documentation was written.

 

10. Re-activate any Virus protection software you previously disabled.

11. Eject the Nuendo CD-ROM and store it in a safe place.

 

You may want to browse the CD-ROM and copy additional files to your hard disk. 

 

❐

 

You will need this CD-ROM if you have to re-install the program.

12. If you are using audio hardware with an ASIO driver (see page 24), locate this driver and 
copy it into the folder “ASIO Drivers” within the Nuendo program folder on your hard disk.

 

This allows Nuendo to access the driver and your audio hardware.
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Setting up Your System
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Setting up Audio

 

❐

 

Always make all connections with all equipment turned off!

 

Connecting Audio

Exactly how to set up your system is a very personal matter, the following connection 
diagrams should be taken as examples.

The audio connections below may be digital or analog, it doesn’t matter.

Stereo Input and Output - the simplest connection

If you only use a stereo input and output from Nuendo, you might connect your audio 
hardware directly to the input source (a video recorder with dialog to be edited, for 
example) and the outputs to a power amplifier and speaker.

A simple stereo audio setup.

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

L R
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Multi-channel Input and Output

Most likely however, you will have other audio equipment that you want to integrate 
with Nuendo. This will require a mixer, preferably one with a group or bus system that 
can be used for feeding inputs on the audio hardware.

In the example below, four buses are used for feeding signals to the sound hardware’s 
inputs. The four outputs are connected back to the mixer for monitoring and playback. 
Remaining mixer inputs can be used for connecting audio sources like microphones, 
instruments, etc.

A multi-channel audio setup.

Audio    card inputs

Audio card outputs

Amplifier and speakersMixer

Inputs
1 to 4

Bus
1 to 4 L R
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Connecting for Surround Sound

If you plan to mix for surround sound, you could connect the audio outputs to a multi-
channel power amplifier, driving a set of surround channels.

A surround sound playback configuration.

Nuendo supports a number of surround formats. The example connection above will 
work for mixing both 5.1 and LRCS (ProLogic for example) where in this case the two 
surround speakers will be playing the same material (from the single surround chan-
nel). The only difference between the two formats in this aspect is the LFE channel, 
which is not used with LRCS.

Recording from a CD player

Most computers come with a CD-ROM drive that can also be used as a regular CD 
player. With some audio hardware, the CD player can be connected internally to the 
hardware, allowing you to record the output of the CD player directly into Nuendo. 

• Under Windows, routing and level adjustments for recording from a CD are done in the 
audio hardware setup application (see page 33).

• On a Macintosh, you will most likely need to select the ASIO SoundManager driver (see 
page 34) to be able to record from a CD. You will also need to select the CD as input source 
in the Mac’s Sound control panel.

• You can also grab audio tracks directly from a CD in Nuendo (see the Operation Manual). 

Audio card inputs

Audio card outputs

Amplifier and speakersSource to be recorded

L R

RCL

Rs/S

LFE

Ls/S
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Word Clock Connections

If you are using a digital audio connection you may also need a word clock connection 
between the audio hardware and external devices. Please refer to the documentation 
that came with the audio hardware for details.

❐ It is very important that word clock synchronization is done correctly or there might be 
clicks and crackles in recordings that you make!

Making Audio Driver Settings

About the Audio Hardware Setup application

Most audio hardware models come with one or more small applications that allow 
you to configure the inputs of the hardware to your liking. This includes:

• Selecting which in/outs are active.
• Setting up word clock synchronization (if available).
• Turning monitoring via the hardware on/off (see page 37).
• Setting levels for each input. This is very important!
• Setting levels for the outputs, so that they match the equipment you use for monitoring.

For more details about your audio hardware setup application please refer to the docu-
mentation that came with the hardware.
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VST Multitrack setup - Basic Settings

1. In Nuendo, select Device Setup from the Devices menu and click on VST Multitrack in the list.
Make sure the “Setup” tab is selected.

The VST Multitrack panel in the Device Setup dialog.

2. Select your audio hardware from the ASIO Driver menu.
There may be several options here that all refer to the same audio hardware.

❐ We strongly recommend that you access your hardware via an ASIO driver written specif-
ically for the hardware, if available. If no ASIO driver is installed we recommend that you 
check with your audio hardware manufacturer if they have an ASIO driver available, for 
example for download via the Internet.

3. Click the Control Panel button and adjust the settings as recommended by the audio hard-
ware manufacturer.
The control panel that appears when you click this button is provided by the audio hardware 
manufacturer and not by Nuendo (unless you use DirectX or MME drivers under Windows, see 
below). Hence it will be different for each audio card brand and model. The settings may include 
options for buffering, synchronization, digital input and output formats etc.
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• The Control panels for the ASIO Multimedia and ASIO DirectX drivers (Windows version 
only) are an exception, as they are provided by Steinberg. 
They are described in the Online Help, opened by clicking the Help button in the respective 
dialog. See also the notes below.

4. If you plan to use several audio applications simultaneously, you may want to activate the 
option “Release ASIO Driver in Background”. This will allow another application to play 
back via your audio hardware even though Nuendo is running.
The application that is currently active (i.e. the “top window” on the desktop), will get access to 
the audio hardware.

5. If your audio hardware and its driver support ASIO Direct Monitoring, you may want to ac-
tivate the Direct Monitoring checkbox.
Read more about monitoring later in this chapter and in the Recording chapter in the Operation 
Manual.

6. Click Apply and then OK to close the dialog.

If you are using Audio Hardware with a DirectX Driver (Windows only)

There are two ASIO DirectX drivers available with Nuendo: 

• ASIO DirectX.
This driver allows audio output only, not audio input (in other words, playback only, not record-
ing). It is therefore not a suitable choice if you want to record audio in Nuendo (but it can be 
used for mixing and playback).

• ASIO DirectX Full Duplex.
This driver allows both audio recording and playback. However:

❐ To be able to take full advantage of DirectX Full Duplex, the audio hardware must support 
WDM (Windows Driver Model) in combination with DirectX version 6.1 or higher. 
In all other cases, the audio inputs will be emulated by DirectX (see the online help for the 
ASIO DirectX Full Duplex Setup dialog for details about how this is reported). Since using 
emulated inputs will result in higher latency, you may want to use the ASIO Multimedia 
driver instead, as this gives you some more possibilities to fine-tune the settings.
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If you are using Audio Hardware with a Windows Multimedia (MME) Driver

When you select the ASIO Multimedia Driver for the first time, the system will ask you 
whether you want to test the configuration. We strongly recommend that you perform 
this test. If it fails, or if you for other reasons need to make adjustments to your ASIO 
Multimedia configuration, click the Control Panel button to open the ASIO Multimedia 
Setup control panel included with Nuendo. This control panel comes with an Online 
Help describing the features and procedures.

If you are using the built-in Audio Hardware on a Macintosh

To use the built-in audio hardware on a Macintosh, you need to select the Apple Sound 
Manager driver in the Device Setup dialog. Furthermore, you need to select the desired 
input in the Sound control panel of the Macintosh.

❐ Depending on the MacOS version, you may need to quit Nuendo before making Sound 
control panel settings.

About Recording Levels and Inputs

When you connect your equipment, take care about the absolute operating levels of 
the various input options. Apart from the obvious difference in level and impedance 
of a microphone input, please take care over +4 dBV and -10 dBV connections.

It is very important to make sure you use the correct type of input on your audio hard-
ware, or your recordings will either be distorted or unnecessarily noisy. 

❐ Nuendo does not provide any input level adjustments, since these are done differently for 
different audio hardware. Adjusting input levels is either done in a special application in-
cluded with the hardware or possibly from its ASIO Control Panel.
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About Monitoring

In Nuendo, Monitoring means listening to the signal being recorded while preparing 
to record or while recording. There are basically three ways to monitor:

External monitoring

External monitoring (listening to the input signal before it goes into Nuendo) requires 
an external mixer for mixing the audio playback with the input signal. This mixer could 
be a stand-alone physical mixer or a mixer application for your audio hardware, if this 
has a mode in which the input audio is sent back out again (usually called “Thru”, “Direct 
Thru” or similar).

Via Nuendo

In this case, the audio passes from the input into Nuendo, possibly through Nuendo 
effects and EQ and then back to the output. You then control monitoring via settings 
in Nuendo.

ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO Direct Monitoring. 
In this mode, the actual monitoring is done in the audio hardware, by sending the in-
put signal back out again. However, monitoring is controlled from Nuendo. This means 
that the audio hardware’s direct monitoring feature can be turned on or off automati-
cally by Nuendo.

Monitoring is described in detail in the Recording chapter in the Operation Manual. 
However, when setting up, there’s one thing to note:

• If you want to use the external monitoring via your audio hardware, make sure the corre-
sponding functions are activated in the card’s mixer application.
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Setting up MIDI

❐ Always make all connections with all equipment turned off!

This section describes how to connect and set up MIDI equipment. If you have no MIDI 
equipment you can skip this section.

Connecting the MIDI Equipment

In the description below you will find a typical but small setup example. You might need 
or want to hook things up differently!

In this example we assume that you have a MIDI keyboard and an external MIDI sound 
module. The keyboard is used both for feeding the computer with MIDI messages for 
recording and for playing back MIDI tracks. The sound module is used for playback only. 
Using Nuendo’s MIDI Thru feature (described later) you will be able to hear the correct 
sound from the sound module while playing the keyboard or recording.

A typical MIDI Setup.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru
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You might want to use even more instruments for playback. If you do, simply connect 
MIDI Thru on the sound module to MIDI In on the next instrument, and so on. In this 
hook-up, you will always play the first keyboard when recording. But, you can still use 
all your devices for providing sounds on playback.

❐ If you plan to use more than three sound sources, we recommend that you either use an 
interface with more than one output, or a separate MIDI Thru box instead of the Thru 
jacks on each unit.

Setting up a Default MIDI Input and Output

You may want to make sure that new Tracks that you create are set to the desired MIDI 
ports. Proceed as follows:

1. In Nuendo, select Device Setup from the Devices menu and click on Default MIDI Ports in 
the list.
Make sure the Setup tab is selected.

2. Use the two pop-ups to select an input and an output.
Now, newly created Tracks will always use this input and output. However, you can later change 
this setting for each individual Track in the Project window.

3. Click Apply and then OK to close the dialog.
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Setting MIDI Thru and Local On/Off

In the “MIDI” section in the Preferences dialog (opened from the File menu), you will find a 
setting called “MIDI Thru Active” which can be enabled or not. This is related to a setting in 
your instrument called “Local On/Off” or “Local Control On/Off”.

• If you use a MIDI keyboard instrument, as described earlier in this chapter, MIDI Thru should be 
activated and that instrument should be set to Local Off (sometimes called Local Control Off – 
see the instrument’s operation manual for details). This will let the MIDI signal from the keyboard 
get recorded into Nuendo and at the same time be re-routed back to the instrument so that you 
hear what you are playing, without the keyboard “triggering” its own sounds.

• If you use a separate MIDI keyboard, that does not produce any sounds itself, MIDI Thru in 
Nuendo should also be activated, but you don’t need to look for any Local On/Off setting in
your instruments.

MIDI Keyboard

MIDI Sound Module

MIDI
Interface

MIDI

MIDI

In

MIDI In

Out

OutIn

Thru

“Synth” 

When “MIDI Thru” is active in 
Nuendo, MIDI data received is 
immediately “echoed” back out.

When you press a key, it is 
sent out via MIDI to Nuendo.

MIDI data coming in to the 
instrument is played by the 
“Synth” inside it.

When Local Control is On in the instrument, the keys you 
press will be played by the “Synth” inside the Instrument.
When Local Control is turned Off, this connection is cut off.
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• The only situation where MIDI Thru should be deactivated is if you use Nuendo with only one 
keyboard instrument and that instrument cannot be set to Local Off mode.

• Note that MIDI Thru will only be active for MIDI Tracks that are Record Enabled. See the Record-
ing chapter in the Operation Manual for more information.

Connecting a Synchronizer

❐ Always make all connections with all equipment turned off!

When using Nuendo with external tape transports you will most likely need to add a 
synchronizer to your system. All connections and setup procedures for synchronization 
are described in the Synchronization chapter in the Operation Manual.

Setting up Video

❐ Always make all connections with all equipment turned off!

Nuendo plays back video films in AVI, Quicktime or MPEG formats and supports a large 
range of video hardware. Nuendo for Windows plays back video using one of three 
playback engines: Video for Windows, DirectShow or Quicktime. Nuendo for Macintosh 
always uses Quicktime. 

Generally there are two ways to play back video:

• Without any special hardware at all, using the computer CPU.
In this case, the “codec” is in software. While this will be fine in many situations it does put a limit 
on the size of the video window as well as the quality of the image.

• Using video hardware that for example connects to an external monitor.
This hardware must then use a suitable codec and have the proper drivers. Please visit 
www.nuendo.com for more information about video hardware support.

• If you plan to use special video hardware, install it and set it up as recommended by the 
manufacturer.

• Before you use the video hardware with Nuendo, we recommend that you test the hard-
ware installation with the utility applications that came with the hardware.
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Optimizing Audio Performance

This section of the chapter gives you some hints and tips on how to get the most out 
of your Nuendo system, performance-wise. Some of this text refers to hardware prop-
erties and can be used as a guide when upgrading your system. This text is very brief. 
Look for details and current information on the Nuendo web site (see page 10)!

Two Aspects of Performance

There are two distinct aspects of performance in respect to Nuendo:

Tracks and Effects

Simply put: the faster your computer, the more tracks, effects and EQ you will be able to 
play. Exactly what constitutes a “fast computer” is a science almost in itself, but some 
hints are given below.

Short Response Times (Latency)

Another aspect of performance is response times. Latency is a phenomenon based on 
the fact that in a computer, audio has to be “buffered” (stored) in small chunks during 
various steps of the recording and playback process. The more and larger those chunks, 
the higher the latency.

High latency is most troublesome when monitoring through the computer (listening 
to a live audio source via the Nuendo mixer and effects) and when playing VST Instru-
ments in real time. However, very long latency times (several hundred milliseconds) 
can hamper other processes like mixing, since for example a fader movement will af-
fect the audio noticeably late.

While Direct Monitoring and other techniques reduce the problems associated with 
very long latency times, a system that responds fast will always be more convenient to 
work with.

• Depending on your audio hardware, it may be possible to “trim” your latency times, usu-
ally by lowering the size and number of buffers.
For details, refer to the audio hardware documentation. If you are using a DirectX or MME driver 
(Windows only), you will also find additional information in the Online Help.
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System Factors that Affect Performance

CPU and Processor Cache

It goes without saying that the faster the computer processor, the better. But there are 
a number of factors that affect the apparent speed of a computer: the bus speed and 
type (PCI is strongly recommended), the processor cache size and of course, the pro-
cessor type and brand.

Nuendo relies heavily on floating point calculations. When shopping for a processor, 
please make sure you get one that is powerful in calculating floating point arithmetic. 
When using Nuendo for Windows, original Intel processors have proven to be a safe 
choice.

Hard disk and Controller

The number of hard disk tracks you can record and play back at the same time also de-
pend on the speed of your hard disk and hard disk controller. Normally, E-IDE disks and 
controllers suffice well, but someone building a system specifically for hard disk record-
ing should consider getting a fast SCSI card and disk.

Audio Hardware and Driver

The hardware and its driver can have some effect on regular performance. A badly writ-
ten driver can reduce the performance of your computer. But where the hardware driver 
design makes the most difference is with latency.

❐ Again, we strongly recommend that you use audio hardware for which there is a specific 
ASIO driver!

ASIO drivers written specifically for the hardware are more efficient than MME, 
DirectX or Apple Sound Manager, and normally produce shorter latency times.
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Making Settings that Affect Performance

Choosing a Driver for your Audio Hardware

As described on page 34, it is recommended to install and use a standard ASIO driver 
if available for your specific hardware.

Making Disk Buffer Settings

These settings can be found in the VST Multitrack panel in the Device Setup dialog 
(opened from the Devices menu). The two parameters “Number of Disk Buffers” and 
“Disk Buffer Size” govern how data is read and written from/to the hard disk.

When data is read from disk it is stored in a buffer. Since the computer has to fill the 
buffer at the same time as it is playing back data, there needs to be more than one 
buffer. The same is true for recording. You can adjust both the number of buffers used 
for each audio channel and their size.

With more and larger buffers, you will get smoother performance, since less computer 
processing power is “wasted” to accessing the hard disk (it can to some extent com-
pensate for a slower processor). However, enlarging the values also raises latency and 
requires you to have proportionately greater amount of RAM.

Making Control Panel Settings

In the control panel for your audio hardware you may also find buffer settings. Gener-
ally, the smaller the value for these, the lower the latency. On the other hand, working 
with small buffers can be demanding for the computer. If the audio hardware buffers 
are too small, the audio can be garbled or distorted.

Multi Processing and Expert Settings

In the VST Multitrack panel you will find a button called Expert. This opens a dialog 
with advanced settings for the VST Engine, including a Multi Processing switch. When 
this is turned on (default setting) and there is more than one CPU, the mixing is distrib-
uted to all available CPUs, allowing Nuendo to make full use of the multiple processors. 
See the Online Help for details.

The other settings in this dialog can normally be left at their default values. However, if 
you run into problems with audio playback you should investigate whether changing 
these settings will help. Generally, they allow you to adjust how much processing 
power is used for audio recording and playback. Again, see the Online Help for details.
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The Main Windows in Nuendo

The Project Window

The Project window is the main window in Nuendo. This provides you with a graphic 
overview of the Project, allowing you to navigate and perform large scale editing. The 
Project window is divided vertically into Tracks and has a time line going from left to 
right. Each Project has one Project window.

Tracks of different 
types.

The Project Cursor.

The area with 
various settings to 
the left is called 
the Track List.

The area to the right in the Project window is called 
the Event Display. This is where you view and edit 
Audio and MIDI Events, Automation curves, etc.



 47

The Project Browser

The Project Browser window provides a list based representation of the Project. This 
allows you to view and edit all Events on all Tracks by using regular value editing in a 
list.

The Transport Panel

The Transport Panel features transport controls, much like those found on a conven-
tional tape recorder. It can also be used for locating Marker positions, setting Tempo 
and Time Signature, etc.

Marker Locators

The Tempo and Time Signature displayPosition Display

Transport controls

The Left and Right Locators are used for defining where 
to start and end recording and what section to Cycle.
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The Pool

All Clips, Audio or Video, that belong to a Project are listed in the Pool. There is a sepa-
rate Pool for every Project. In the Pool you can organize, convert and audition Clips, 
amongst many other things.

Audio folder

Trash folder Video folder

Audio Clips

Waveform image
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The Sample Editor

In the Sample Editor you can view and manipulate audio, by cutting and pasting, re-
moving or drawing audio data. By using the Offline Process History, you can undo 
changes or revert to the original versions at any point.

Thumbnail overview.

Waveform view. A selected range.
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The MIDI Editor

Editing MIDI data is done in the MIDI Editor. The MIDI Editor window shows the con-
tents of a single MIDI Part.

MIDI notes are represented by “boxes”, with the 
vertical position corresponding to the pitch.

This section is called the Controller display. It shows “continuous” MIDI Events 
(such as Controllers) or as in this figure, the velocity values of notes.
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The Tempo Track Editor

For each audio and MIDI Track, you can specify whether it should be time based or 
tempo based. Tempo based Tracks follow a tempo, which can either be fixed through 
the whole Project or follow the Tempo Track. In the Tempo Track Editor you can draw 
curves that determine how the tempo will change over time.

Time Signature Events

The Tempo Curve
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The VST Mixer

The VST Mixer is where you mix your audio channels, that is, adjust the levels (volume), 
stereo panning, effect sends, EQ, etc.

The Common Panel 
contains settings that 
affect all mixer channels.

Level fader

Level meter

Channel automation 
controls

Pan control
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Channel Settings

The Channel Settings window is used for adding effects and EQ to individual Audio or 
Group Channels. Each Channel has its own Channel Settings window.

VST Send Effects

The VST Send Effects “rack” is where you select and activate Send Effects. There is a 
similar window for selecting and activating effects in the master output path.

Channel Inserts Channel Sends Equalizer section
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VST Outputs and Master Gain

In the VST Outputs window you can set the output level of each Output Bus. The num-
ber of Buses depends on your audio hardware.

The output level of the Master Bus is controlled with the Master Gain fader in the VST 
Mixer. The Master Bus may be in stereo or have several channels, depending on the 
chosen configuration. It is connected to the corresponding number of VST Output 
Buses.

Stereo Bus Faders

Bus Active button

Bus output routing pop-up. This is where 
each Output Bus is routed to a physical 
output on the audio hardware.

The Master Bus and 
Master Gain fader in a 
stereo configuration. 
Clicking the “Inserts” 
button opens the Mas-
ter Effects window.

The Master Bus and Master 
Gain fader in a multi-channel 
(surround) configuration. 
Clicking the “Ins” button 
opens the Master Effects 
window.
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About this Chapter

This chapter contains a step-by-step description of how to make a simple audio re-
cording and play it back. The purpose is for you to try out some of the most common 
recording and playback features. However, you should make sure to read the Record-
ing chapter in the Operation Manual before doing any “serious” recording, as there are 
a lot of settings, options and methods that are not mentioned here.

Before you start

This chapter assumes the following:

• You have installed and set up your audio hardware.

• Your audio source (a mixer or tape recorder, for example) is properly connected to the 
inputs of the audio hardware.

• The outputs of the audio hardware are connected to some sort of listening equipment, 
allowing you to listen to the recorded audio during playback.

• You are monitoring your audio source externally. 
That is, when you are recording, you listen to the audio source before it goes into Nuendo. A typ-
ical setup would be to have an audio source connected to an external mixer, and feed the signal 
into Nuendo via an auxiliary bus or send, while listening to the output of the mixer. 
Note that this is just to make things simple in this chapter - there are various ways to monitor the 
signal through Nuendo, as described in the Recording chapter in the Operation Manual.

• You have launched Nuendo.
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Creating a new Project

Before you can start recording, you need a working environment - a Project:

1. Pull down the File menu and select “New Project”.
A dialog appears, listing a number of Project Templates for various purposes.

2. Click on the “Empty” item in the list and click OK.
A file dialog appears, allowing you to specify a location for the Project folder. This will contain all 
files related to the Project. 

The next step is different for Windows and Mac:

3. Windows: Navigate to the desired location of the Project folder and type the name of the 
folder in the “Directory” field. Click Select.

3. Mac: Navigate to the desired location of the Project folder, click the New Folder button 
and enter the name of the folder. Click Choose.

The Project folder is created on disk, and an empty Project window appears.

At this point, you can make various settings for the Project, such as sample rate, reso-
lution, etc. However, to keep things simple we will use the default settings for now. 
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The next step is to create an Audio Track to record on:

4. Pull down the Project menu and select “Add Track”.
A submenu appears, listing the various types of Tracks available in Nuendo.

5. Select “Audio”.
An empty Audio Track appears in the Project window.
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Preparing to record

Before you can start recording, there are some preparations to make:

Selecting Stereo or Mono

You need to decide whether you want the recording to be in stereo or mono. This is 
done by clicking the Stereo/Mono button in the area to the left of the Audio Track.

• In this example, set the Track to stereo by clicking the button so that it lights up and 
shows a double circle.

Activating and Routing Inputs

1. Pull down the Devices menu and select “VST Inputs”.
The VST Inputs window appears. This lists all audio inputs on your audio hardware, allowing you 
to turn inputs on or off.

2. Locate the input pair to which you have connected your audio source, and make sure its 
“On” button in the Active column is lit.
If not, click the button to turn the input on.
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3. Close the VST Inputs window, and open the VST Mixer from the Devices menu.
This is Nuendo’s mixer window, used for setting levels, etc. The VST Mixer contains an audio 
channel strip for each Audio Track in the Project window, so currently there will be a single 
stereo channel strip.

4. Click on the arrow button at the top of the channel strip, to pull down the Input pop-up 
menu.
This is where you select which audio input should be routed to the audio channel for recording.

5. Select the input pair to which you have connected your audio source.
Your audio source is now routed to the audio channel, so that it can be recorded on the Audio 
Track.

Let the VST Mixer window remain open for now.
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Checking the Input Level

To avoid clipping, you need to check the input level before recording:

1. Click the “In” button above the level meters (next to the fader on the mixer channel strip).
When the “In” button is lit, the level meter will show the input level (as opposed to the level of 
the playback signal).

2. Activate your audio source.
You will see the level meters reacting.

3. Adjust the output level of your audio source so that the meters go as high as possible 
without activating the red Clip indicator above the meters.
If the Clip indicator lights up, the input level is too high. Reset the Clip indicator by clicking on it, 
lower the output level of the audio source and try again.
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Making the Track ready for recording

1. Make sure the Transport Panel is visible.
If not, pull down the Transport menu and select the “Transport Panel” item at the top.

The Transport Panel.

2. Make sure the buttons on the Transport Panel are set up like this:

If any of these buttons are lit, click on them to deactivate them.

3. Click in the Ruler (the time scale area above the Track in the Project window), at the posi-
tion where you want to start recording.
When you click, the Project Cursor (the black vertical line) is automatically moved to the click 
position.

Setting the Project Cursor position in the Ruler.

4. Click on the “R” button in the area to the left of the Track, so that it starts blinking.
The Track is now Record Enabled.

You are ready to record!

The Record 
Enable button.
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Recording

1. Start recording by clicking the Record button on the Transport Panel.
The “R” button will light up (stop blinking), and the Project Cursor will start moving.

2. Play your instrument, etc.
During recording, a rectangle will appear, covering the recorded area. This is the recorded Au-
dio Event.

3. When you are done, click the Stop button on the Transport Panel.
Recording stops. Nuendo will calculate a waveform image of your recording and display it in the 
Audio Event.

4. If you are done with recording, click the “R” button in the area to the left of the Track, so 
that it goes dark.

Playing back what you just recorded

1. Move the Project Cursor to the beginning of the recorded Audio Event.
This could either be done by clicking in the Ruler, or by using the Rewind button on the Trans-
port Panel.

2. Click the Play button on the Transport Panel.
Your recording will be played back.

3. When you are done, stop playback by clicking the Stop button on the Transport Panel.
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Recording more Events

At this point, you may want to continue recording audio, on the same Track or on a new Track.

Recording more on the same Track

To record more audio on the same Track, move the Project Cursor to a new start posi-
tion and proceed as when you recorded the first time.

❐ It is possible to record audio events that overlap each other, but only the visible events 
(the events at the top) will be heard when you play back.

Recording a new Audio Track

This example shows how to record a new Audio Track, while listening to the first re-
cording.

1. Create a new Audio Track by using the “Add Track” submenu on the Project menu.

2. Decide whether you want the new Track to be stereo or mono by using the Stereo/Mono 
button in the area to the left of the Track.

3. Pull down the Devices menu and open the VST Mixer.
As you can see, a new channel strip has been added to the Mixer.

4. Use the Input pop-up menu at the top of the channel strip to make sure that the correct 
audio input is selected for the new Track.
If the audio source is another than the one you first recorded, you need to check the input level 
again - see page 61.

5. In the Project window, Record Enable the new Track by clicking its “R” button.
Make sure that the “R” button for the first Track is disabled - otherwise you will be recording on 
both Tracks at the same time.

6. Move the Project Cursor to the desired start position.

7. Activate recording by clicking the Record button on the Transport panel.
While you are recording, the first Audio Track is played back.

8. When you are done, click the Stop button on the Transport panel.
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Playing back in a Cycle

You could continue starting and stopping playback this way, moving the Project Cur-
sor manually each time. However, if you want to try out some mixing features (see the 
next chapter), it is more practical to have Nuendo play back your recorded audio re-
peatedly, over and over again:

1. Click on the recorded Audio Event to make sure it is selected.
A selected Audio Event has red and blue handles at its beginning and end.

2. Pull down the Transport menu and select “Locators to Selection”.
This moves the Left and Right Locator (two special Nuendo markers) to the beginning and end 
of the selected Audio Event, respectively. In the Ruler, the area between the Left and Right Loca-
tor is indicated by a green line.

3. Click the Cycle button to the left on the Transport Panel so that it lights up.

4. Move the Project Cursor to the beginning of the recording and click Play.
Playback starts. When the Project Cursor reaches the end of the recording (the Right Locator), it 
will immediately jump back to the Left Locator and continue playback. Leave playback running 
for now.
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Mixing
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About this Chapter

This chapter contains basic descriptions of the VST Mixer and information on how to 
use the effects and automation in Nuendo. The purpose is to introduce the basic ele-
ments involved when mixing audio. However, for complete descriptions of these three 
areas, you should refer to the chapters “The VST Mixer and Effects Windows”, “Effects” 
and “Automation” in the Operation Manual, as there are a lot of settings, options and 
methods that are not mentioned here.

Before you start

This chapter assumes the following:

• That you have opened a Project, containing at least one Audio Track and some Audio Events 
that you can play back.
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Opening the VST Mixer

To open the VST Mixer, select it from the Devices menu.

The VST Mixer window is similar in appearance to a conventional hardware mixer, with 
a level fader for each audio channel strip. The VST Mixer will contain the same number 
of channels as the number of Audio Tracks present in the current Project. Beside each 
channel’s level fader, there is a level meter which indicates the signal level of audio 
events on the corresponding Audio Track during playback.
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Setting Level and Pan

1. With the VST Mixer window still open, activate playback.
Make sure that you have a mixer channel playing back a signal in view.

2. Click on the level fader handle and drag down or up.
You will hear the volume of the playback signal being changed. The meters will also reflect the 
change of level.

3. Click on the blue line in the Pan control box above the fader, and drag to the left or right.
You will hear the stereo balance being changed.

Adjusting Pan.

Mute and Solo

Each channel strip has a Mute and a Solo button, allowing you to silence one or sev-
eral audio channels. The following applies:

• The Mute button silences the selected channel.
Several Channels can be muted simultaneously. A muted channel is indicated by a lit Mute button.

• The Solo button mutes all other channels, so you only hear the selected channel.
A soloed channel is indicated by a lit Solo button. Several channels at a time can be soloed. For 
“exclusive Solo” (only one Soloed channel at a time), press [Ctrl] (Windows) or [Command] (Mac) 
and click the Solo button. 
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Adding EQ

For each channel in the VST Mixer, there is a Channel Settings window. This contains a 
duplicate channel strip, Send and Insert Effect sections (see page 72), and an Equalizer 
(EQ) section. Equalization shapes the tone of a signal by boosting and/or cutting se-
lected frequencies. To add EQ to a Channel, proceed as follows:

1. Click the “EQ” button for the desired channel in the VST Mixer.
The Channel Settings window opens.

2. Activate as many EQ modules as you need (up to four) by clicking the “On” buttons.

3. Set the parameters for the activated EQ module(s) by using the knobs.
The EQ curve display in the EQ section will reflect the parameter settings. You can also make set-
tings directly in the display, by dragging curve points.

The Equalizer section.
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Adding Effects

Send Effects

When you use send effects, audio is routed through the effect processors via indepen-
dent Effect Sends for each channel, just like on a “real” physical mixer.

1. Pull down the Devices menu and select “VST Send Effects”.
An “effect rack” window appears, with eight slots, all empty.

2. Click in the black field for the effect slot at the top (in the area that says “No Effect”).
A pop-up menu appears, listing all available effect plug-ins.

3. Select an effect from the list.
The effect is loaded into the first effect slot. The lit red “Power button” indicates that the effect is 
activated.

• You can make settings for the effect by clicking the “Edit” button, but for now we will just 
use the default settings.
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4. In the VST Mixer, click on the “FX” button at the top of the channel strip.
The Channel Settings window appears. This is where you set up the effect sends.

5. In the Sends section, locate the first send (the one at the top of the left send column).
Note that an abbreviation of the effect name is shown in the name field below the send level 
knob.

6. Click the “On” button for the first send, so that it lights up.
The send is now activated.

7. Click on the send level knob for the first send and turn it up by dragging the mouse.
You will hear the effect being added to the channel being played back.

The Sends section.
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Insert Effects

An insert effect is inserted into the signal chain of an audio channel, which means that 
the whole channel signal passes through the effect. To route an audio channel through 
Insert Effects, proceed as follows.

1. Locate the channel you want to add insert effects to, and click the “Ins” button.
The Channel Settings window opens. To the left of the Sends section, you can find four Insert 
Effect slots.

2. Click in the Effect type field for one of the Insert slots, and select an effect from the pop-up 
menu that appears.

3. Activate the effect by clicking the “On” button.
The Channel is now routed through the Insert effect.

The Inserts section.
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Master Effects

Master effects are added to the signal on the Master bus, the final mix output. They 
operate like Insert effects, i.e. the whole Master bus signal passes through the effect.

1. Pull down the Devices menu and select “VST Master Effects”.

2. An “effect rack” window appears, with eight slots, all empty.

3. Click in the “No Effect” slot and select an effect from the pop-up menu.
When you select an effect, an effect panel opens in the slot.

4. Make sure the red “Power button” is lit.
The Master bus is now routed through the Master effect.
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Automating the VST Mixer

Virtually every VST Mixer and Effect parameter can be automated. Each Channel has an 
Automation Track which is by default hidden. When you use Write Automation the au-
tomation Events that are generated are recorded on the corresponding channel’s Auto-
mation Track. These Events can be viewed and edited on Automation “subtracks”, one 
for each channel parameter that has been automated. Automation subtrack editing is 
described in the chapter “Automation” in the Operation Manual.

Using Write/Read Automation

There are separate Write (W) and Read (R) buttons for each channel in the VST Mixer, 
and for the Master fader. 

The Write (W) and Read (R) buttons for a channel in the Mixer, and for an Automation subtrack in the 
Track List.

• If you activate Write for a channel, all mixer parameters you adjust during playback for that spe-
cific channel will be recorded.

• If you activate Read for a channel, all your recorded mixer actions for that channel will be per-
formed during playback, just like you performed them in Write mode.

There are also Global Read/Write buttons in the VST Mixer’s Common Panel. 

• When Write All is activated, all VST Mixer actions you perform during playback (for all channels) 
will be recorded as Automation Events.

• When Read All is activated, all your recorded mixer actions for all channels will be performed 
during playback.
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An Example

For a quick step by step description of Write/Read automation, proceed as follows:

1. Open the VST Mixer.

2. Activate Write automation for a channel by clicking the “W” (Write) button.
The button lights up.

3. Start playback.

4. Move the channel fader up or down.

5. While still in playback, adjust the Pan by clicking the blue line in the Pan control box 
above the fader and dragging to the left or right.

6. Click Stop on the Transport Panel, and go back to the position where you activated play-
back.

7. Click on the Write button to deactivate Write mode.

8. Click on the Read button so that it lights up.
Read mode is now activated.

9. Start playback.
The Volume fader and Pan control will now mirror the actions performed while in Write mode.

• To redo anything that was recorded, activate Write mode again, and start playback from 
the same position.

• You may have Write and Read activated simultaneously, if you want to watch and listen to 
your recorded mixer actions while you’re recording fader movements for another mixer 
channel, etc.
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Editing in the Project Window
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About this Chapter

This chapter describes some of the procedures for editing in the Project window. Typ-
ically, this is where you do the “large-scale” editing and rearranging of Events.

• Although the following examples describe editing Audio Events, many of the techniques 
can also be applied to Audio Parts and MIDI Parts. 
For details and full descriptions, see the chapters “The Project Window” and “Fades and Cross-
fades” in the Operation Manual.

Selecting Events

To select Events in the Project window, proceed as follows:

1. Make sure the Arrow tool is selected.
If not, click on the Arrow icon in the Toolbar.

2. To select a single Event, click on it. 
To select several Events, use [Shift]-clicking or click and drag a selection rectangle.

Selected Events are displayed with red and blue handles at the edges. These are used for resizing, 
changing the gain and creating fades, respectively (see page 82 and page 84).
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Moving and Copying Events

To move Events in the Project window, proceed as follows:

1. If you want to move more than one Event, select them as described above.
If you want to move a single Event, you don’t need to select it.

2. Click on one of the Events with the arrow tool and drag it to the desired position.
If Snap is activated on the Toolbar, this determines the exact position of the moved Events. See 
page 83.

When you are moving several Events, they will keep their relative positions.

• To make copies of Events, hold down [Alt] (Windows) or [Option] (Mac) and proceed as 
when moving.
There are also special Duplicate and Repeat functions, as described in the Operation Manual.
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Resizing an Event

You can resize Events by dragging their start or end edges, thereby “hiding” material 
at the start or end:

1. Make sure the Arrow tool is selected.

2. Click on the Arrow tool icon so that a small pop-up menu appears.

3. Make sure “Normal Sizing” is selected.
The other option is described in the Operation Manual.

4. Select the Event you want to resize.
The red resize handles appear at the lower edges of the Event.

5. Click on a resize handle and drag it to the left or right.
The Event is resized. If Snap is activated on the Toolbar, this determines the resulting length of 
the resized Event (see below).
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About the Snap Setting

When you are rearranging and editing Events in the Project window, it is often useful 
to have a “guide”, helping you to find the correct positions. This is the purpose of the 
Snap setting on the Toolbar. Let’s say you are moving Events, and want them lined up 
so that one Event should start exactly where the previous Event ends:

1. Pull down the Snap pop-up menu on the Toolbar.
This determines which positions should be used for snapping.

2. Select the “Events” option.
In this mode, Events will snap to the end and start positions of other Events. The other Snap op-
tions are described in the Operation Manual.

3. Click the Snap on/off button to activate Snap.

Snap activated on the Toolbar.

4. Try moving an Event.
You will find that the start of the moved Event is “magnetic” to the start and end of other Events.
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Creating a Fade-in

There are several ways to create fades, as described in the Operation Manual. This ex-
ample shows how to create a fade-in using the fade handles in the Project Window:

1. Select the Event.
The blue fade handles appear at the upper edges of the Event.

2. Click on the fade handle at the beginning of the Event, and drag it to the right.
This creates a fade-in of the default shape (initially a linear fade). 

3. If you now play back the Event, you will hear the volume gradually rising in the fade-in 
area.

If you don’t want the fade to have the default shape, you can adjust this in the Fade di-
alog. Let’s say you want a smooth, more exponential fade-in:

4. With the Event selected, pull down the Audio menu and select “Open Fade Editor(s)”.
The Fade In dialog appears. You can also open this by double clicking on the actual fade curve.

The current fade shape is shown on top of the audio waveform in the graphic display.

5. Click the left “Curve Kind” button.
With this selected, the fade curve will consist of spline-curve segments, rather than linear 
segments.
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6. Click on one of the Curve Shape buttons below the display.
These are preset curve shapes, but you can also modify the shape manually by clicking and 
dragging in the display (see the Operation Manual).

7. Click “OK”.
The dialog is closed and the new curve shape is applied to the fade-in.

Creating a Crossfade

Audio Events on the same Track can be crossfaded, to create a smooth transition. In 
this example, we have two Audio Events positioned so that they overlap slightly, and 
the crossfade will be created in the overlapping area:

1. If necessary, resize the Events so that the overlapping section is suitably long.
You may want to zoom in to see what you’re doing - use the horizontal zoom slider in the lower 
right corner of the Project window.

2. Select one of the Events (or both).

3. Pull down the Audio menu and select “Crossfade”.
A crossfade is created in the overlapping area, with the default shape (initially linear).

The overlapping area.
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4. To modify the crossfade, make sure one or both Events are selected, and select “Cross-
fade” from the Audio menu again.
The Crossfade dialog appears.

This is similar to the Fade dialog (see page 84), but has separate sections for the fade-
in and fade-out parts of the crossfade.

5. Modify the crossfade shape by using the Curve Shape buttons or by clicking and dragging 
in the curve displays.
You can use the “Play Fade” buttons to listen to the fade-in and fade-out separately, and the “Play” 
button to listen to the crossfade with the current settings. The other options in the dialog are de-
scribed in the Operation Manual.

6. Click “OK” to apply the settings and to close the dialog. Clicking “Apply” applies the 
changes without closing the dialog.
The crossfade is adjusted.
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Adjusting the Volume of an Event

If you want to adjust the volume of an Audio Event, you can do this by dragging the 
volume handle (the blue handle in the middle of the Event’s upper edge).

• You can also adjust the volume of a selected Event on the Info line (above the Event dis-
play, shown by clicking the “i” button on the Toolbar).
This allows you to boost the volume by up to 6 dB if you like.

Undoing the Editing

You can always undo any action you have performed by selecting “Undo” from the 
Edit menu. The number of Undo levels can be specified in the Preferences, and you 
can also view and edit the entire Undo history in a separate dialog. See page 139.
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About this Chapter

This chapter describes the basic procedures for editing audio in the Sample Editor and 
how to use the Process functions. For a full description of all settings, options and oper-
ations available, please refer to the chapters “The Sample Editor” and “Audio Processing 
and Functions” in the Operation Manual.

The Sample Editor

The Sample Editor allows you to edit audio, by cutting and pasting, removing, drawing 
or processing audio data. This editing can be called “non-destructive”, in the sense that 
you can undo changes or revert to the original versions at any point, using the Offline 
Process History (see page 96).

What is shown in the Sample Editor?

As described on page 116, an audio event plays a section of an Audio Clip. When you 
open the Sample Editor for an audio event, it will display the waveform image of the 
corresponding Audio Clip. Above the Waveform display is the Thumbnail display, which 
provides an overview of the whole Clip, with a blue rectangle corresponding to the sec-
tion currently shown in the Waveform display. You can navigate by dragging or resizing 
the blue rectangle in the Thumbnail display.
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Editing audio in the Sample Editor - an example

This example describes how to remove a section of audio and insert it at another posi-
tion, by using cut and paste in the Sample Editor:

1. Open the Sample Editor by double clicking an audio event in the Project window.

2. Select the Range Selection tool by clicking its icon on the Toolbar.

3. Select a section of the Clip by clicking and dragging in the Waveform display.
The cursor changes to an arrow as you start dragging.

Click at the position where you want the selection to start and drag...
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...to make a selection range.

4. Release the mouse button when the selection is complete.
You can adjust the selection by dragging its edges.

5. Select “Cut” from the Edit menu.
The selection is removed from the Clip and moved to the Clipboard.

The section to the right of the selection is moved to the left to fill out the gap.
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Selecting “Paste” from the Edit menu will copy the data on the Clipboard into the Clip 
according to the following rules:

• If there is a selection in the editor, the pasted data will replace it. 

• If there is no selection (if the selection length is “0”), the pasted data will be inserted start-
ing at the selection line. 
The selection line can be placed at any position in the Event by clicking with the mouse. The sec-
tion to the right of the line will be moved to make room for the pasted material.

6. For this example, make the end of the event visible, either by using the scrollbar or by 
moving the blue rectangle in the Thumbnail, and click to place the selection line at the 
event end position.

7. Now select “Paste” from the Edit menu.
The selection that was cut from the event is inserted at the position of the selection line.
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Processing Audio

The Process submenu on the Audio menu contains a number of audio processing 
functions. The functions can be applied to selected audio events or Clips, or to a se-
lected range. 

In this example, we will apply Normalizing to a selected audio event. The Normalize 
function allows you to specify the desired maximum level of the audio. A common use 
for Normalizing is to raise the level of audio that was recorded at too low an input 
level.

Proceed as follows:

1. Select an audio event by clicking on it with the Arrow tool in the Project window.

2. Pull down the Audio menu and select Process.
A submenu opens, containing all processing functions available.

3. Select “Normalize” from the submenu.
The Normalize dialog opens. 

4. For this example, use the default “Maximum” setting of 0.00 dB.

• You can use the “Preview” button to listen to the result of the processing if you wish.
The processing will not be applied, just auditioned.

5. Click “Process” to apply the processing.
The audio event is normalized. 
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Applying an Effect Plug-in

As described on page 72, you can add “real-time” effects in the VST Mixer. However, 
sometimes it is useful to apply an effect directly to an audio event or Clip. This is done 
using the Plug-ins submenu on the Audio menu:

1. Select an audio event in the Project window.
In this example, we select the event that was Normalized in the previous example.

2. Pull down the Audio menu and select Plug-ins.
A submenu appears, listing all installed effect plug-ins.

3. Select the “AutoPan” effect.
The AutoPan dialog appears.

4. Use the parameters in the upper part of the dialog to set up the effect as desired.
Clicking the Preview button will let you audition the settings before actually applying the effect.

5. Click the “Process” button to apply the effect.
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Using the Offline Process History Dialog

The Offline Process History dialog allows you to remove or modify audio processing at 
any time. It is even possible to modify or remove some processing “in the middle” of 
the Process History, while keeping later processing! Whether this is possible or not de-
pends on the type of processing performed, as described in the chapter “Audio Pro-
cessing and Functions” in the Operations Manual.

In this example, we will remove the Normalize function, but keep the applied AutoPan 
effect:

1. Select the audio event in the Project window.

2. Pull down the Audio menu and select “Offline Process History”.
The Offline Process History dialog appears. This contains a list of the processing functions ap-
plied to the Audio Clip, with the most recent operation at the bottom of the list.

3. Select the “Normalize” action by clicking in the list.

4. Click the “Remove” button.
You are asked whether you really want to remove the processing.

5. Click “Remove”.
The Normalize processing is removed, but the AutoPan effect is kept.
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About this Chapter

This chapter describes the basic operations for recording MIDI and editing in the MIDI 
Editor. For a full description of MIDI recording and editing please refer to the chapters 
“Recording” and “MIDI Editing and Functions” in the Operation Manual. 

Before you start

This chapter assumes that you have correctly connected your MIDI equipment accord-
ing to the instructions in the chapter “Installation and Requirements for Windows/Ma-
cintosh” in this book.

About MIDI Thru

The normal way to work with MIDI is to have MIDI Thru activated in Nuendo, and Local 
Off selected in your MIDI Instrument(s). In this mode, everything you play during record-
ing will be “echoed” back out again on the MIDI Output and Channel selected for the re-
cording Track. 

• Pull down the File menu and open the Preferences dialog (MIDI page) to make sure the 
option “MIDI Thru Active” is activated, and then follow the steps below.
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Setting Up for Recording MIDI

Creating a MIDI Track

To create a MIDI Track, proceed as follows:

1. Pull down the Project menu, and select “Add Track”.
A submenu appears.

2. Select MIDI from the submenu.
A MIDI Track is added to the Track List.

Setting the MIDI Input 

1. To set the MIDI Input for a Track, pull down the Input pop-up in the Track List and select 
an Input.
The available MIDI Inputs are shown. On the Macintosh, the items on the menu depend on the 
settings you have made in the OMS Setup application, under Windows they depend on the type 
of MIDI interface you are using etc. 

Click here to set the MIDI Input.

2. Record Enable the MIDI Track by clicking the “R” button in the Track list.
MIDI Thru is automatically activated when the Track is Record enabled.

3. Play a few notes on your MIDI instrument, and check the Level meter in the Track List to 
make sure that the MIDI signal is received.
If not, check that you have correctly set up your MIDI system, as described on page 38.
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Setting the MIDI Output and Channel

1. To set the MIDI Output for a Track, pull down the Output pop-up in the Track List and se-
lect the Output to which you have connected your MIDI device.
The available MIDI Outputs are shown. Again, the items on the menu depend on the OMS set-
tings (Macintosh) and the connected MIDI interface(s) (Windows). If you have any VST Instru-
ments activated, they will be listed here as well.

Click here to set the MIDI output.

2. To set the MIDI Channel for a Track, use the MIDI Channel pop-up in the Track List.
If you set the Track to MIDI channel “Any”, it will transmit MIDI on the channel(s) used by the 
MIDI input device (the MIDI instrument you play during recording). 

Click here to set the MIDI channel.

Selecting a sound

• To select different sounds, you can send Program Change messages to your MIDI device 
using the Program value field in the Track List.

Click here to select a Program number.

Program Change messages give access to 128 program locations. If your MIDI instru-
ments have more than 128 programs, Bank Select messages (set in the Bank value 
field) allow you to select different Banks, each containing a number of programs.

• Play some notes on your MIDI instrument to check that the right sound is selected.
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Recording MIDI 

1. Make sure the Track is Record enabled and correctly set up, as described in the previous 
section.

2. Make sure that Cycle and Punch In/Out is deactivated on the Transport Panel.

3. Place the Project Cursor at the position where you wish to begin recording.

4. Activate Record on the Transport Panel, and play a few notes on your MIDI instrument.
When you finish recording, a MIDI Part containing MIDI Events is created in the Project 
window. 

Creating a MIDI Part Manually

You can also manually create an empty MIDI Part:

1. Select the Pencil tool from the Toolbar.

2. Click and drag in the Project window on a MIDI Track.
This creates an empty MIDI Part.

Drawing a MIDI Part.
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Editing MIDI

Opening the MIDI Editor

• You open the MIDI Editor by double clicking a MIDI Part in the Project window. 
The Editor window shows the contents of a single Part. You can have several Editors open at the 
same time.

The MIDI Editor window.

• The Note display is the main area in the MIDI Editor. It contains a grid, in which MIDI notes 
are shown as boxes. 
The width of a box corresponds to the note length, and the vertical position of a box corre-
sponds to the note number (pitch), with higher notes higher up in the grid. 

• The piano keyboard to the left serves as a guide for finding the right note number. 

• The area at the bottom of the MIDI Editor window is the Controller display. 
This is used for viewing and editing various values and Events, such as velocity (see page 107).
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Drawing Events in the MIDI Editor

When you move the pointer in the Note display, its bar position is indicated in the 
Toolbar, and its pitch is indicated both in the Toolbar and on the piano keyboard to 
the left. This makes it easy to find the right note and insert position.

To insert new notes in the MIDI Editor, proceed as follows:

1. Select the Pencil tool. 

2. Click at the desired time position and pitch (height).

A note is inserted with the following additional properties:

• If you just click once, the created note will get the length set on the Length Quantize pop-
up menu on the Toolbar.
You can create a longer note by clicking and dragging the pointer to the right with the mouse 
button pressed. The length of the created note will be a multiple of the Length Quantize value.

• The notes will get the Insert Velocity value set on the Toolbar.
Velocity values are viewed and edited in the Controller display, see page 107.
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About Snap

Snap activated on the Toolbar.

The Snap function helps you find exact positions when editing in the MIDI Editor. It 
does this by restricting horizontal movement and positioning to certain positions. Op-
erations affected by Snap include moving, duplicating, drawing, sizing, etc.

• When the “Bars+Beats” display format is selected in the Ruler, the Quantize value on the 
Toolbar determines the Snap value.

• When any time-based display format is selected in the Ruler, editing snaps to the visible 
grid.

Selecting and Moving Events

To select Events in the MIDI Editor window, proceed as follows:

1. Make sure the Arrow tool is selected.
If not, click on the Arrow icon in the Toolbar.

2. To select a single Event, click on it. 
To select several Events, use [Shift]-clicking or click and drag a selection rectangle.

To move Events in the MIDI Editor window, proceed as follows:

1. If you want to move more than one Event, select them as described above.
If you want to move a single Event, you don’t need to select it.

2. Click on one of the Events with the arrow tool and drag it to the desired position.
If Snap is activated on the Toolbar, this determines the exact position of the moved Events. 



 105

About Quantize

Quantizing in its fundamental form is a function that automatically moves recorded 
notes, positioning them on exact note values. 

• Quantizing affects MIDI notes only (not other Event types). 
• In the Project window, Quantizing applies to all selected Parts, affecting all notes within them.
• In the MIDI Editor, Quantizing applies to all selected notes. If no notes are selected, all notes will 

be affected.

Here follows a simple step by step example of using the Quantize function:

1. Let’s say you have recorded a series of eighth notes, which you have opened for viewing 
in the MIDI Editor.
As shown in the illustration below some of them have ended up slightly beside the exact eighth 
note positions.

Now there are two basic ways you can proceed:

• To Quantize all notes in the Part, no notes need to be selected.

• To Quantize separate notes in the Part, select them.
Only the selected notes will be Quantized.

In this example, we have chosen to leave all note Events in the Part unselected.
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2. Open the Quantize pop-up menu on the Toolbar.
The menu contains three main categories of note values, Straight, Triplet and Dotted.

3. For this example, select straight 1/8 Note Quantize from the menu.

4. Select “Quantize” from the MIDI menu.
This quantizes the MIDI notes according to the Quantize pop-up menu setting.

Straight note values

Triplet note values

Dotted note values
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Editing Velocity in the Controller Display

The MIDI Editor Controller display is used for viewing and editing various values and 
Events. The Controller display shows one Event type at a time. 

• If you click the arrow to the left of the Controller display, a pop-up appears allowing you 
to select what Event type you wish to view. 
For this example, select “Velocity”.

• When “Velocity” is selected for viewing, the Controller display shows the velocity of each 
note as a vertical bar.

Velocity Events in the Controller display.

• To change the velocity of a single note, click on its velocity bar with the Pencil tool, and 
drag the bar up or down. If there are several notes on the same position only the velocity 
value of the selected note is changed. If there is no note selected the velocity values for all 
notes on this position will be changed.
While you drag, the current velocity value is shown in the display to the left.

• To change the velocity values of several notes, you can either draw a “velocity curve” with 
the Pencil tool or use the Line tool to create a velocity ramp.
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An Example

In the following example we will create a velocity ramp using the Line tool:

1. Add some notes in the Note display by using the Pencil tool.

2. Select the Line Tool.

3. Click where you want the ramp to start, move the pointer to where you want the ramp to 
end and release the mouse button.
When the mouse button is released, the velocity values will be scaled according to the ramp 
curve.



11
Watching a Video
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About this Chapter

This chapter describes the basic procedures for playing back a video file in Nuendo. 
For a full description of all features available in Nuendo relating to this subject, please 
refer to the chapter “Video” in the Operation Manual. 

Selecting a Video Playback Engine (Windows only)

Under Windows, Nuendo can play back video using one of three different playback 
engines: DirectShow, Quicktime or Video for Windows. This ensures compatibility 
with as wide a range of video hardware as possible. Under MacOS, all video playback is 
done using Quicktime, which is what we will use in the following example.

❐ Since Quicktime is always used under MacOS, the following selection is only necessary un-
der Windows:

1. Pull down the Device menu and select “Device Setup”.
The Device Setup dialog appears.

2. In the list of devices to the left, click on the “Video Player” device.
The Video Player settings are displayed under the “Setup” tab to the right in the dialog.

3. Make sure “QuickTime Video” is selected on the Playback Method pop-up menu.

4. Click OK to close the dialog.
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Creating a Video Track

To play back a video file in Nuendo, you first have to create a Video Track:

• From the Project menu, select “Add Track”, and then select “Video” from the submenu 
that appears.
The Video Track is added to the Track list. You can only have one Video Track in each Project.

Importing a File

When the QuickTime playback engine is selected, Nuendo can import and play back 
video films in the formats Quicktime, AVI and MPEG. To import a video file, proceed as 
follows:

1. Select the Video Track, by clicking it in the Track list.

2. Pull down the File menu and select “Import”, then select “Videofile...” from the submenu 
that appears.
This opens a file dialog, allowing you to locate the file you wish to import. 

• In the lower left side of the Import Video dialog, there is a tick box named “Extract audio”. 
If ticked, this will add any audio contained in the video file to a new, automatically created 
audio track. 
The new audio event will start at the same time as the video event, so that they are in sync with 
each other.

3. Locate and select the file, and click Open.
When you import a file this way, a Clip is created for the video file and an Event that plays the 
whole Clip is added to the Video Track, at the position of the Project Cursor.
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Playing it back

Playback is done together with all other material, using the Transport panel. Video 
files are displayed as Events/Clips on the video track, with thumbnails representing 
the frames in the film.

• Pull down the Devices menu and select “Video”.
A video window appears. In stop mode, this displays the video frame at the Project Cursor 
position.



12
Basic Nuendo Concepts
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About this Chapter

This chapter describes the basic “building blocks” and terminology in Nuendo. Please 
take your time to read this chapter thoroughly before moving on!

The Project

The native document format of Nuendo is called a Project. Before you can start record-
ing, playing back or editing you always have to create a new Project, or open a saved 
Project file from disk. There can be several Projects open at the same time, but one is 
always the active Project.

Two Project windows in Nuendo. The Project to the left is the active Project, as indicated by the lit red 
light indicator in the upper left corner of the window.

About the File and Folder Structure

A Project file (file extension “.npr”) is always associated with a Project folder on your 
hard disk. Several Projects can share the same Project folder (which is practical if you 
have several versions of your Project, for example). 
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Typically, a Project folder is structured like this:

• The Audio folder contains audio files referenced by the Project.
It is also possible for the Project to refer to audio files elsewhere on your disk(s), but having all 
audio files in the Project’s Audio folder makes the Project easy to move and archive, and is a 
good safety measure.

• The Edits folder contains audio files created automatically by editing and processing op-
erations in Nuendo.
As a rule, you shouldn’t touch the files in this folder. To remove unused edit files, it is better to 
use the Cleanup function, as described in the Operation Manual.

• The Fades folder contains audio files created by fade and crossfade operations in Nuendo.

• The Images folder contains waveform images for the audio files in the Project.

• The Project file itself contains all references to audio and video files, along with playback 
information, MIDI data and settings for the Project (such as sample rate, frame rate, etc).

• Video files are never automatically copied to the Project folder.
This is because video files are often very large, and it doesn’t make sense to copy them into differ-
ent Project folders. However, nothing stops you from creating a Video folder inside the Project 
folder and storing your video files there.

• You may also find additional files in the Project folder.
For example, Nuendo’s Auto Save feature stores backup copies of the Project file in its Project 
folder.
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Audio Terminology

When you record Audio in Nuendo, this is what happens:

• An Audio File is created on the hard disk.
• In Nuendo, an Audio Clip is created. The Audio Clip refers to the audio file on disk.
• An Audio Event is also created in Nuendo. This plays back the Audio Clip.

There are good reasons for this long chain of references:

• The Audio Event is the object that you place on a time position in Nuendo. If you make copies of 
an Audio Event and move them to different positions in the Project, they will still all refer to the 
same Audio Clip. 
Furthermore, each Audio Event has an Offset value and a Length value. These determine at 
which positions in the Clip the Event will start and end, i.e. which section of the Audio Clip will 
be played back by the Audio Event. For example, if you resize the Audio Event, you will just 
change its start and/or end position in the Audio Clip - the Clip itself will not be affected.

• The Audio Clip does not necessarily refer to just one original recorded file! 
For example, if you apply some processing to a section of an Audio Clip, this will actually create a 
new audio file that contains only the section in question. The processing will then be applied to 
the new audio file only, leaving the original audio file unchanged. Finally, the Audio Clip is auto-
matically adjusted, so that it refers both to the original file and to the new, processed file. During 
playback, the program will switch between the original file and the processed file at the correct 
positions. You will hear this as a single recording, with processing applied to one section only.
This feature makes it possible to undo processing at a later stage, and to apply different process-
ing to different Audio Clips that refer to the same original file.
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Audio Tracks, Parts and Channels

For an Audio Event to be played back in Nuendo, it has to be placed on an Audio Track. 
This is similar to a track on a multi-track tape recorder, and allows you to view the Event 
and move it along the timeline. You can place any number of Audio Events on an Audio 
Track, but only one at a time can be played back. You can have up to 500 Audio Tracks, 
although the number of Tracks you can play back at the same time depends on your 
computer performance.

Even though Audio Events can be placed directly on Audio Tracks, sometimes it is con-
venient to gather several Audio Events into an Audio Part. This is simply a “container”, 
allowing you to move and duplicate several Audio Events as one.

An Event and a Part on an Audio Track.

Each Audio Track has a corresponding Audio Channel in the VST Mixer. This is much 
like a channel on a hardware mixer, allowing you to set levels and panning, add EQ 
and effects, etc.
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MIDI Terminology

When you are recording MIDI (or entering MIDI data manually in an editor), MIDI Events 
are created. For example, each note you record is a separate MIDI Event, and if you 
record the movement of a modulation wheel or other controller, a large number of 
densely spaced Events are created.

MIDI Events are always placed in MIDI Parts. These are “containers”, allowing you to 
move or copy a number of MIDI Events (e.g. a recorded MIDI melody line) as one item.

MIDI Parts are placed on MIDI Tracks. For each MIDI Track you can specify on which 
MIDI Output and MIDI Channel its MIDI Events should be played back. This allows you 
to have different Tracks play back different sounds, in the same or different MIDI 
instruments.

A MIDI Part on a MIDI Track. The black lines in the Part indicate MIDI Events.

Video Terminology

• When you import a video file from disk into a Nuendo Project, a Video Clip is created that refers 
to the file. 

• A Video Event is then created, referring to the Video Clip. Video Events can be moved, copied 
and resized without affecting their Video Clips. 

• For a Video Event to be played back, it has to be placed on the Video Track. There can only be 
one Video Track in a Nuendo Project.

The video support in Nuendo is described in its own chapter in the Operation Manual.



13
Basic Methods
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About this Chapter

This chapter contains descriptions of the general methods and procedures used in 
Nuendo. As this information applies to all parts of the program and all ways of working, 
please take time to read this chapter before continuing with the Operation Manual. 

Using Menus

Main Menus

The menus in the main Nuendo menu bar are always available, regardless of which win-
dow is active. However, menu items that are not relevant in the current window may be 
greyed out. You select items from the main menus following the standard procedure of 
the operating system.

Pop-up Menus

Pop-up menus can be found throughout the program and are often used for selecting 
options or values. A pop-up menu is indicated by an arrow button next to a field show-
ing the currently selected option/value. 

• To bring up the pop-up menu, click the arrow button. 
Selecting is done as with regular menus.

Selecting from the Snap pop-up menu.
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The Quick Menu

In Nuendo, clicking the right mouse button (Windows) or [Ctrl]-clicking (Mac) will bring 
up a contextual pop-up menu. Some areas have special context menus with functions 
or settings that only apply to the corresponding area (for example, right-clicking/[Ctrl]-
clicking in a Ruler brings up a pop-up menu with display format options). 

However, right-clicking (Win) or [Ctrl]-clicking (Mac) in the main area of a window 
brings up the Quick menu. As a rule, the Quick menu contains:

• The tools (provided that the window has tools).
See page 122.

• The most relevant menu items from the main Nuendo menus.

• Settings that are specific for the window.
For example, in the Sample Editor the Quick menu contains settings for which Elements should 
be displayed in the Waveform display.

The Quick menu in the Sample Editor.

❐ If you are using Nuendo on a Macintosh, we recommend that you get a two-button mouse 
and set up the right button to generate [Ctrl]-click. This would allow you to access the con-
text menus by right-clicking.
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Using Tools

Editing in Nuendo is largely done with the various tools. Typical examples are select-
ing and moving Events with the Arrow (Object Selection) tool, drawing with the Pencil 
tool, deleting with the Eraser tool, etc. There are different tools for different windows.

Tools can be selected in three ways:

• By clicking the corresponding Tool icon on the Toolbar.
When you click a Tool icon, the pointer takes on the shape of the corresponding tool.

• By using the Quick menu.
As described on page 121, clicking with the right mouse button (or [Ctrl]-clicking, on the Mac) in 
the main area of a window brings up the Quick menu. The tools will be listed (along with their 
corresponding icons) at the top of the menu - to select a tool, simply select it from the menu.

• By using key commands.
By default, the keys [1] - [0] on the alphanumeric part of the keyboard are used, so that pressing 
[1] selects the leftmost tool and so on. You can also use key commands to step between the tools 
on the Toolbar. By default, pressing [F9] selects the previous tool and pressing [F10] selects the 
next tool.

❐ The uses and purposes of the tools in the different windows are described in the corre-
sponding chapters of the Operation Manual.
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About Tool Tips

If you position the pointer over a Tool icon (or any other icon or button in Nuendo), a 
label will appear after a moment, informing you of the function of the icon or button. 

• This feature can be turned off by deactivating the option “Show Tips” on the User Interface 
page in the Preferences dialog (accessed from the File menu).

Changing Values

Throughout the program you will encounter various value fields that can be edited. 
These can be divided into three categories: position values, regular numeric values 
and names.

Editing Position Values

Depending on the selected display format (see the Operation Manual), position values in 
Nuendo are usually divided into several “segments” (the exception being the “Samples” 
display format, in which values are edited as regular numeric values). Two examples:

If the “Seconds” display format is selected, positions are shown as hours:minutes:seconds.milliseconds.

If the “Bars+Beats” display format is selected, positions are shown as “bars.beats.1/16th notes.ticks” 
(with 120 ticks per 1/16th note).

Each value segment can be edited separately, in one of the following ways:

• Point at the upper or lower edge of the segment and click.
Clicking at the upper edge will raise the value of the segment one step, clicking at the lower 
edge will lower the value.

• Point and click directly on the value segment, type a new value and press [Return].
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• If you are using a wheel mouse, point at the value segment and use the wheel to raise or 
lower its value (Windows only).
If you are using Nuendo under Windows, a wheel mouse can speed up editing in many areas.

You can also edit the whole value (all segments) by double clicking and typing in a 
new value. Note:

• To separate the value segments, you can use spaces, dots, colons or any other character 
that isn’t a number.

• If the “Bars+Beats” display format is selected, and you enter a value with less than four 
segments, the largest position value segments will be affected and the program will set 
the lesser segments to their lowest values.
For example, if you enter “5.3”, the position will be set to “5.3.1.0”.

• If one of the frame based display formats (all formats called “fps” or “dfps”) is selected, 
and you enter a value with less than four segments, the smallest position value segments 
will be affected and the program will set the larger segments to their lowest values.
For example, if you enter “2:5”, the position will be set to “0:0:2:5”.

• If the “Seconds” display format is selected, value editing works as with the frame based 
formats, with one addition: The smallest value segment (milliseconds) is considered to be 
the decimal part of the seconds segment.
This means that if you enter “2:50”, the position will be set to “0:0:2:500”, rather than “0:0:2:050”.
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Editing Regular Numeric Values

Numeric values other than positions are edited by clicking the value and editing nu-
merically from the computer keyboard.

• For some values, you can hold down [Alt] (Windows) or [Option] (Mac), click on the value 
and keep the mouse button pressed to display a value slider.
This allows you to scroll the value by dragging up or down with the mouse button pressed. 
When you release the mouse button, the value slider is hidden.

Adjusting the Event Volume setting on the Info line.

• Under Windows, these values can also be edited using a wheel mouse: point at the value 
and use the wheel to raise or lower it.

Editing Names

To edit a name, click on it, type a new name and press [Return] (or click outside the 
name field).



126

Using Knobs and Faders

In the VST audio windows, most parameters are shown as knobs, sliders and buttons, 
emulating real-world hardware interfaces. For knobs and sliders, you can select the 
desired way of making adjustments in the Preferences dialog (User Interface-Controls 
page):

Knobs

The Knob Mode pop-up menu contains the following options:

Sliders

The Slider Mode pop-up menu contains the following options:

Option Description

Circular To move a knob, you click on it and drag in a circular motion, much like turning a “real” 
knob. When you click anywhere along the knob’s edge, the setting is immediately 
changed.

Relative Circular Works like the “Circular” option, but clicking does not automatically change the setting. 
This means you can make adjustments to the current setting by clicking anywhere on a 
knob and dragging, without having to click on the exact current position.

Linear To move a knob, you click on it and drag up or down (or left or right) with the mouse 
button pressed - as if the knob were a vertical (or horizontal) slider.

Option Description

Jump In this mode, clicking anywhere on a slider will make the slider handle instantly move to that 
position.

Touch In this mode, you have to click on the actual slider handle to adjust the parameter. This re-
duces the risk of accidentally moving sliders.

Ramp In this mode, clicking anywhere on a slider (but not on the actual handle) and keeping the 
mouse button pressed, will cause the handle to move smoothly to the new position.
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Selecting Objects

Selecting Nuendo objects such as Audio and MIDI Events is generally done with the 
Arrow tool, according to standard selection procedures.

• Clicking on an object selects it (and deselects any previously selected objects).

• Holding down [Shift] and clicking on an object selects it without deselecting any other 
objects.

• You can also create a selection rectangle by clicking in an empty area and dragging with 
the mouse button pressed.
All objects partially or totally enclosed by the rectangle will be selected.

• If an object is already selected, you can use the left and right arrow key on the computer 
keyboard to select the previous or next object, respectively.
Holding down [Shift] and using the arrow keys allows you to select the previous/next object 
without deselecting the current object.

❐ There are several additional ways to make selections in the different Nuendo windows. 
These are described in the corresponding Operation Manual chapters.
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Zoom and View Techniques

Scrolling the View

If the active window isn’t large enough to show all its contents, you can scroll the view 
by using the standard window scroll bars. However, if you are using a wheel mouse 
with Nuendo for Windows, there are two additional ways to scroll:

• Rolling the wheel will scroll the view horizontally.
If you hold down [Shift] and use the wheel, the view will be scrolled vertically. Just make sure 
not to point at a value field, as this will edit the value instead.

• If you aim in the main area of a window, click the wheel and keep it pressed, the pointer 
takes on the shape of a hand. You can now scroll the view freely by dragging the mouse 
horizontally and/or vertically. 

❐ The Macintosh system does not offer full support for the wheel mouse. However, with 
some wheel mouse models, scrolling may still be possible.

Zooming

All windows that contain graphical displays can be zoomed horizontally and vertically. 
While some windows have special zoom functions (see the respective chapter in the 
Operation Manual), a few methods are commonly available:

Using the Zoom Sliders

At the lower right corner of all zoomable displays, you will find two zoom sliders.

• To zoom in horizontally, drag the horizontal zoom slider handle to the right.
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• To zoom in vertically, drag the vertical zoom slider upwards.
There is one exception to this: in the Project window, dragging the vertical zoom slider upwards 
will decrease the height of Tracks (in effect, zooming out). See the chapter “The Project Window” 
in the Operation Manual.

• Clicking on a zoom slider will move the handle to the click position, instantly changing the 
magnification.

❐ If the Project Cursor is visible when you zoom in or out horizontally, the magnification will 
be “centered on the Cursor”. In other words: if possible, the Project Cursor will remain in 
the same position on screen.

Using the Magnifying Glass Tool

You can use the Magnifying Glass tool to zoom in and out horizontally, using the fol-
lowing methods:

• Click once to zoom in one step.
Zooming will be centered on the click position.

• To zoom out one step, double click or press [Alt] (Windows) or [Option] (Mac) and click.

• Draw a zoom rectangle by pressing the mouse button, dragging the pointer and releasing 
the mouse button.
The view will zoom in horizontally, so that only the area enclosed in the zoom rectangle is visible.
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Using the Zoom Menu

At the bottom of the Edit menu, you will find a Zoom submenu with various zoom func-
tions. Exactly which items on the submenu are available depends on the currently active 
window.

• The Zoom submenu is also available as a separate menu item on the Quick menu.

• As with any menu item, you can specify key commands for the functions on the Zoom sub-
menu, for quick access.
Key commands are set up in the Key Commands dialog on the File menu, described in a sepa-
rate chapter in the Operation Manual.

Zooming in the Ruler

If the option “Zoom while Locating in Time Scale” is activated in the Preferences dia-
log (Transport page), you can use the Rulers for zooming. This allows you to quickly 
zoom in or out on a certain position, without having to select a special tool:

1. Click in the Ruler and keep the mouse button pressed.
The Project Cursor is automatically moved to the click position. If you don’t want to move the 
Cursor, press [Shift] and click in the Ruler instead.

2. Drag down to zoom in (horizontally) or drag up to zoom out.
Zooming will be centered on the Project Cursor.
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Window Handling

Generally, Nuendo windows are handled according to the standard procedures. How-
ever, the Window menu contains some functions that make work quicker and easier:

❐ Some of the functions are available in the Windows version only.

❐ Note that there will be a number after the Window menu in the menu bar. This indicates 
the currently selected Window Layout (see page 134).

Menu item Description

Close Closes the currently active window. If this is a Project window, you will close the cur-
rent Project.

Close All Closes all windows, including all open Projects.

Minimize All Minimizes all windows.

Restore All Restores all minimized Nuendo windows.

Tile Horizontally/
Tile Vertically

Arranges the open windows next to each other on screen. Windows version only.

Cascade Arranges the open windows in a partially overlapping pattern. Windows version only.

Window Layouts See page 134.

Windows... See page 132.

Open windows list Selecting a window from the list at the bottom of the menu brings it to front.
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The Windows dialog

By selecting “Windows...” from the Window menu, you open the Windows dialog. This 
allows you to manage the open windows in various ways.

The display to the left lists all open windows, hierarchically arranged (so that editors 
and other windows that belong to a certain Project are listed under the corresponding 
Project window). To the right are various window functions. To use one of the func-
tions, proceed as follows:

1. Click in the field below the OK button to select one of the selection modes: 

2. If you selected the “Selected” or “Cascaded” modes, select the desired windows by click-
ing in the list.
To select multiple items, press [Shift] or [Ctrl] (Windows) / [Command] (Mac) and click.

Mode Description

Selected Only the windows selected in the list will be affected.

Cascaded The selected windows will be affected, along with all their “under-windows”. Typically, if 
a Project window is selected in the list, all open windows belonging to that Project will be 
affected.

All All windows will be affected, regardless of the selection.
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3. Use the buttons to the right to activate (bring to front), minimize, restore or close the 
specified window(s).
Closing a window will also remove it from the list.

4. When you are done, click OK to close the dialog.

The Device Panel

If you like, you can manage VST Audio windows and the Video window from a central 
Device panel:

1. Pull down the Devices menu and select “Show Panels”.
The Devices Panel appears.

2. To display a closed or hidden window, click on its button in the Devices Panel.

3. Clicking the button again will close the window.
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Working with Window Layouts

A configuration of windows for the active Project is called a “Window Layout”. By storing 
different window combinations as Window Layouts, you can quickly switch between 
different working modes. You may for example want as large as possible a Project win-
dow when you are editing, whereas you may want the Mixer and Effect windows open 
during mixdown. Window Layouts are listed and managed on the Window Layouts sub-
menu on the Windows menu.

Basic Rules

• There will always be at least one Window Layout in a Project. 

• One Window Layout is always Active (selected).
The Active Layout is indicated by a tick mark on the Windows Layout submenu, and by the num-
ber after the Window menu on the menu bar (if the menu is titled “Window1”, this means that 
Window Layout 1 is Active, etc.).

• If you haven’t specifically created or edited Window Layouts, there will be a single item on 
the Window Layouts submenu, called “Layout 1”. 
This contains the current configuration of windows in the Project, and will be continuously ad-
justed when you open, close or move windows (since the Layout isn’t locked - see next point).

• Window Layouts can be locked or unlocked.
If the Active Layout is unlocked, any changes you make to the window configuration (e.g. by 
opening or moving windows) are automatically stored in the Layout. If the Active Layout is 
locked, you can still change the window configuration as usual, but the changes are not stored. 
Activating the same Layout again will bring back the original (stored) Window configuration.

• For each Layout, you can specify which window properties (zoom, window position and/
or Track height) should be affected when you make the Layout active.

• It is also possible to create Window Layouts which are global to all open Projects.
These work in a slightly different way, as described on page 138.
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Editing the Active Window Layout

To make changes to the Active Window Layout, proceed as follows:

1. Make sure the item “Lock Active Layout” isn’t ticked on the Window Layouts submenu.

2. Make the desired changes to the window configuration.
This may include opening, closing, moving and sizing windows, and adjusting zoom and track 
height.

The changes are automatically stored for the Active Layout.

3. If you like, lock the Layout by selecting “Lock Active Layout” from the Window Layouts 
submenu.
This makes sure that you don’t accidentally change the Window Layout. You can also use a key 
command for this function - the default is pressing [Alt] (Windows) or [Option] (Mac) and [0] on 
the numeric keypad.

Creating a new Window Layout

Before creating a new Window Layout, you may want to make sure the current Layout 
is locked (“Lock Active Layout” is ticked on the Window Layouts submenu). Otherwise, 
the changes you make in step 1 below will affect the current Window Layout as well.

1. Set up the windows you want to include in the Window Layout.
This may include opening, moving and sizing windows, and adjusting zoom and track height.

2. Pull down the Window menu and open the Window Layouts submenu.

3. Select “New...”.

4. In the dialog that appears, enter a name for the Window Layout.
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5. Use the checkboxes to specify which settings should be included in the Window Layout.
Actually, all settings are included, but only the specified properties will be applied when you ac-
tivate the Layout. You can change this setting at any time in the Organize dialog (see below).

6. Click OK.
The Window Layout is stored and will appear on the Window Layouts submenu. It will now be 
the Active Layout.

• By default, new Window Layouts are not locked.

Activating a Window Layout

1. Pull down the Window menu and open the Window Layouts submenu.

2. Select the Window Layout from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the stored Window Layout.

• You can also activate any of the first nine Window Layouts using key commands.
By default, this is done by pressing [Alt] (Windows) or [Option] (Mac) and the corresponding key 
on the numeric keypad ([Alt]/[Option]-[1] selects Layout 1, and so on).
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Organizing Window Layouts

If you select “Organize...” from the Window Layouts submenu, a dialog opens, listing 
all available Window Layouts.

• To rename a Window Layout, double click its name in the list and type in a new name.

• To adjust the properties of a Window Layout, use the checkboxes.

• To create a new Window Layout based on the current window configuration, click the 
New button.
The new Layout appears in the list allowing you to adjust its name and properties.

• To activate a Layout, either select it and click the Activate button, or double click in the 
number column to the left.
The Layout is activated and the dialog is closed (unless the “Keep window open” checkbox is 
ticked).

• To remove a Window Layout, select it in the list and click the Remove button.
The Layout is removed from the list.

• To close the dialog, click the OK button.
Note that you can continue working in other windows with the Organize Layouts dialog open.
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Global Window Layouts

While the regular Window Layouts belong to a specific Project, you can also create 
Global Window Layouts, that are available for all open Projects. These are useful for 
defining positions for windows that are not Project specific (such as the VST windows).

• To create Global Window Layouts, you need to close all Projects.
When no Projects are open, you can use the regular Window Layout functions for creating Glo-
bal Window Layouts. When you later open Projects, the Global Window Layouts will be listed at 
the bottom of the Window Layouts submenu.

• When you select a Global Window Layout from the submenu, the stored windows will be 
added to the current window configuration.
Note that the new window configuration will be stored in the current (Active) Project Window 
Layout, provided that it isn’t locked. 

Project specific Window Layouts.

Global Window Layouts.
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Undo

There are two ways to undo operations in Nuendo: by using “regular Undo” and by 
using the Offline Process History. 

• The regular Undo can be applied to virtually all actions you perform, in multiple levels. 
It is accessed by using the “Undo”, “Redo” and “History” items on the Edit menu, as described 
below.

• The Offline Process History allows you to remove and modify applied processing, and is 
different from the “regular” Undo in that you don’t have to undo processing functions in 
the order they were performed. 
The Offline Process History is described in the chapter “Audio Processing and Functions” in the 
Operation Manual.

The Undo and Redo commands

Nuendo offers wide-ranging, multiple Undo, allowing you to undo virtually any action 
you perform.

• To undo the last performed action, select Undo from the Edit menu, or use the corre-
sponding key command. The default Undo key command is [Ctrl]-[Z] (Windows) or 
[Command]-[Z] (Mac).
If you select Undo again, the previously performed action will be undone, and so on.

• To redo the last undone action, select Redo from the Edit menu or use the corresponding 
key command (by default [Ctrl]-[Shift]-[Z] in the Windows version and [Command]-[Shift]-
[Z] on the Mac).
Undone actions will be available for Redo until you perform another action (at which point the 
“Redo Stack” is cleared - see below).

❐ You can specify how many levels of Undo should be available with the “Maximum Undo” 
setting on the User Interface page in the Preferences dialog on the File menu.
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The Edit History window

Selecting “History” from the Edit menu opens the Edit History window. This contains a 
graphic representation of the “Undo Stack” (the performed actions, with the most re-
cent action at the top of the Stack) and the “Redo Stack” (the undone actions, with the 
most recently undone action at the bottom of the Stack). The two stacks are separated 
by a divider line.

The Redo Stack.

The Undo Stack.

The most recently undone action.

The most recently performed action.
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The Edit History dialog allows you to undo or redo several actions in one go, by moving 
the divider between the Undo Stack and the Redo Stack (in essence, moving actions 
from the Undo Stack to the Redo Stack, or vice versa):

1. Click on the divider line and drag it up or down.
Drag up to Redo actions, drag down to Undo them.

In this case, the Delete and Split actions will be Undone (and moved to the Redo stack).

• You can also click directly between two items in the list, instantly moving the divider line.

• When you move the divider line by dragging or clicking, the actions are immediately Un-
done or Redone.
The changes are reflected in all open Nuendo windows.

2. When you’re finished, click OK to close the dialog.

❐ The Undo and Redo Stacks are cleared when you close a Project.
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